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Troubleshoot per Platform

Troubleshoot Java Application Problems
Troubleshoot .NET Application Problems
Troubleshoot PHP Application Problems
Troubleshoot Node.Js Application Problems

Rapid Troubleshooting
Troubleshooting Scenarios
How AppDynamics Indicates Problems
How to Start Troubleshooting 

Troubleshooting
Scenarios

For common troubleshooting
scenarios see:

Troubleshoot Slow
Response Times
Troubleshoot Errors
Troubleshoot Health Rule Violations
Troubleshoot Expensive Methods and SQL Statements
Troubleshoot Mobile Applications

How AppDynamics Indicates Problems

The  show you when problems occur and you need to take action. For example the dashboards Tra
 monitors business transactions and categorizes their performance accordingnsaction Scorecard

to .thresholds

How to Start Troubleshooting 

When AppDynamics indicates a problem you can easily go right into troubleshooting mode.

From the left navigation menu click Troubleshoot.

http://docs.appdynamics.com/display/PRO14S/Dashboards
http://docs.appdynamics.com/display/PRO14S/Scorecards
http://docs.appdynamics.com/display/PRO14S/Scorecards
http://docs.appdynamics.com/display/PRO14S/Thresholds
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Troubleshoot per Platform

Troubleshoot Slow Response Times for Java

Troubleshoot Slow Response Times for .NET

Troubleshoot Slow Response Times for PHP

Troubleshoot Slow Response Times for Node.js

Troubleshoot Slow Network Requests from Mobile
Applications

From the All Applications dashboard click the Troubleshoot link.

 

Troubleshoot Slow Response Times

 

How You Know When
Response Times are Slow
Basic Troubleshooting
Techniques

Slow and Stalled
Transactions

To
troubleshoot
slow and
stalled
transactions

Slow Database and
Remote Service
Calls

To troubleshoot slow database and remote service calls
Learn More

How You Know When Response Times are Slow

There are many ways you can learn that your application's response time is slow:

You received an email or SMS alert from AppDynamics (see  ). The alertAlert and Respond

http://docs.appdynamics.com/display/PRO14S/Alert+and+Respond
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provides details about the problem that triggered the alert.  
Someone reported a problem such as "it's taking a long time to check out" or "the app timed
out when I tried to add an item to the cart."
A custom dashboard shows a problem. 
An AppDynamics dashboard shows a problem. In AppDynamics, look at:

Business Transaction health metrics in the Transaction Scorecard pane.  The bar
charts show slow or stalled transactions (as based on health rules) as compared to
normal.
The Response Time graph. If you see spikes in the graph, the problem is slow
response time.  
Events in the Events List. Scroll the list and look for red or yellow icons related to
performance health rules based on response time. 
Traffic flow lines in a flow map. If you see yellow or red flow lines the problem is likely
to be slow response time.
Business Transaction Health status in the Business Transaction Health pane. If you
see yellow or red bars, there are health rule violations that may affect response time.
Tier icons in the flow map. If the icon is yellow or red there is a problem with one or
more nodes that may affect response time. 
Health rule status in the Server Health pane. If you see red or yellow, the problem
reflects a server health rule violation that may affect response time.  

Basic Troubleshooting Techniques

At any time you can click  and the Slow Response TimesTroubleshoot -> Slow Response Times
window opens showing two tabs. You can drill down into transaction issues in the Slow

, and into database or remote services issues in the Transactions tab Slowest DB & Remote
 tab.Services

Slow and Stalled Transactions

There are many reasons why a business transaction may be slow or stalled. The Slow Response
Times tab helps you find the root cause whether that be resource or thread contention, deadlock,
race condition, or something else.

By default AppDynamics considers a slow transaction one that lasts longer than 3 times the
standard deviation for the last two hours and a very slow transaction 4 times the baseline for the
last two hours.

By default AppDynamics considers a transaction that lasts longer than 45 seconds (4500
milliseconds) to be stalled.

You can configure these thresholds to better match your environment. See  and Thresholds Config
.ure Thresholds

To troubleshoot slow and stalled transactions

1. Click Troubleshoot -> Slow Response Times.
You can also access this information from tabs in the various dashboards.

2. Click the  tab if it is not selected.Slow Transactions

http://docs.appdynamics.com/display/PRO14S/Thresholds
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
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In the upper pane AppDynamics displays a graph of the slow, very slow, and stalled
transactions for the time period specified in the Time Range drop-down menu. If the load is
not displayed, you can click the Plot Load checkbox at the upper right to see the load.
In the lower pane AppDynamics displays the transaction snapshots for slow, very slow, and
stalled transactions.

3. In the lower pane, click the Exe Time column to sort the transactions from slowest to fastest.

To drill down to the root cause of the slow or stalled transaction, select a snapshot from the list
and click . See .View Transaction Snapshot Transaction Snapshots

Slow Database and Remote Service Calls

Although AppDynamics does not instrument database and remote service servers directly, it
collects metrics about calls to these backends from the instrumented app servers. This allows you
to drill down to the root cause of slow database and remote service calls.

To troubleshoot slow database and remote service calls

1. Click .Troubleshoot -> Slow Response Times
You can also access this information from tabs in the various dashboards.

2. Click the  tab if it is not selected.Slowest DB & Remote Service Calls

In the Call Type panel, you can select the type of call for which you want to see information,
or select All Calls. 
The Call panel displays the average time per call, number of calls, and maximum execution
time (Max Time) for the calls with the longest execution time.
In the lower panel, you can see details or correlated snapshots for the selected call.

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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3. Sort by Average Time per Call to display the slowest calls at the top of the list.

4. To see transaction snapshots for the business transaction that is correlated with a slow call, you
can:

Click the  link in the right column to display correlated snapshots in a newView Snapshots
window.
Select the call and click the  tab in the lower panel to displayCorrelated Snapshots
correlated snapshots at the bottom of the screen.

5. Click the Exe Time column to sort the transactions from slowest to fastest.

To drill down to the root cause of the slow call, select a snapshot from the list and click View
. See .Transaction Snapshot Transaction Snapshots

Learn More

Transaction Snapshots
Configure Thresholds

Troubleshoot Expensive Methods and SQL Statements

Expensive Method Invocations and SQL Statements

If a part of your application is showing performance degradation and you're not sure where to start
looking for the root cause,

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
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one approach is to search and compare multiple snapshots together. You can do this to find the
most expensive method invocations and SQL statements.

To troubleshoot by comparing multiple snapshots

1. Select the application dashboard and click the Transaction Snapshot tab.

2. Click the All Snapshots tab.

3. Sort the snapshots in a way that makes sense to you, such as by tier and by business
transaction.

4. Select a few snapshots. You can compare up to 30 snapshots at a time.

5. Click Analyze -> Identify the most expensive calls/SQL statements in a group of
.Snapshots
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Depending on how many snapshots you chose, it may take more time to process the results.
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6. The Expensive Methods and SQL Statements window shows the most expensive method
invocations sorted by total time. You can also sort by average execution time or call count.

7. You can click on a snapshot to see its details.

8. Select two snapshots for the same business transaction and select Analyze -> Compare
 to directly compare them.Snapshots

Learn More
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Transaction Snapshots

Troubleshoot Node Problems

To Access the Node Problem Viewer
Node Problem Viewer
Filter Options for Node Problem Analysis

Baseline to Use
Data to Analyze
Analysis Type

Learn More

AppDynamics categorizes the ten items that deviate the most from the baseline performance as
node problems.

You can analyze node problems from the Node Problems viewer.

The Machine Agent must be installed on the machine hosting the node that you are
troubleshooting.

To Access the Node Problem Viewer

To access the Node Problems viewer do one of the following:

In the Node dashboard, from the Actions drop-down menu click .Analyze Node Problems

or

In the left navigation panel of the Snapshot viewer, click .NODE PROBLEMS

Node Problem Viewer

The right panel of the Node Problem viewer displays the metrics that deviate the most from their
baselines for the specified time range.

The left panel of the Node Problem viewer lets you filter the types of data reported as node
problems.

If accessed from the Snapshot viewer, the Node Problem viewer displays node problems for the
time range of the snapshot. If accessed from the Node dashboard, it uses the time range set in the
Node dashboard. You can edit the time range in the Node Problem viewer and then apply the new
time range. You can also define and save a custom time range.

The selection of metrics displayed depends on the configured filter options.

The following Node Problem viewer shows a transaction that took over 10 seconds (10069 ms) to
execute.

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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It shows that the request count was 62 standard deviations from its normal baseline and that the
DB connection pool was 1.6 standard deviations above its normal baseline. It maxed out at 30
concurrent connections.

The  tab for this snapshot shows the details of the connection pool latency.Hot Spots

In this case, the Node Problems viewer reveals how excessive web requests saturated the DB
connection pool.

Filter Options for Node Problem Analysis

You can filter the following options in the Filter Options panel of the Node Problem viewer:

Baseline to Use
Data to Analyze
Analysis Type
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Baseline to Use

Specify which baseline to use to define node problems:

No baseline
All data - Last 15 days
Daily Trend - Last 30 days (default)
Weekly Trend - Last 6 months
Monthly Trend - Last year

For information about baselines, see .Behavior Learning and Anomaly Detection

Data to Analyze

Select the type of data to analyze from the drop-down menu. AppDynamics analyzes the ten items
that deviate the most from the baseline performance for the specified  type.

Analysis Type

Specify whether to display problems with values that are:

higher than baseline
lower than the baseline
higher and lower than baseline

For example, if you are only interested in CPU that is too high, set the Analysis Type to Higher for
Hardware Resources. On the other hand, if you want to monitor the load on your machine
continuously because low CPU usage would also be a problem, set the Analysis Type to Higher
and Lower.

Learn More

Behavior Learning and Anomaly Detection

Troubleshoot Errors
Error Transactions and Exceptions

To Troubleshoot Error Transactions
To Troubleshoot Exceptions

Learn More
Identifying and troubleshooting errors in your
application.
 

Error Transactions and Exceptions

Metrics on errors are collected in addition to normal business transaction metrics.

An error is defined as one of the following:

An  exception in the context of a business transaction.unhandled
For example:

Business transaction entry point -> some code -> some exception thrown -> business

http://docs.appdynamics.com/display/PRO14S/Behavior+Learning+and+Anomaly+Detection
http://docs.appdynamics.com/display/PRO14S/Behavior+Learning+and+Anomaly+Detection
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transaction finished -> exception caught. In this case AppDynamics reports the
exception.
Business transaction entry point -> some code -> some exception thrown -> exception
caught inside a business transaction -> business transaction finished. In this case
AppDynamics does not report the exception.

 If a business transaction experiences an error, it is counted as an error transaction and
not as a slow, very slow or stalled transaction, even if the transaction was also slow or
stalled. 

Any error that is logged with a severity of Error or Fatal using Log4j or java.util.logging (in
Java), and Log4Net/NLog (in .NET) even if occurs outside the context of a business
transaction. Depending on the signature of the method being called, you might not see an
exception stack trace:

logger.log(Level.ERROR, String msg, Throwable e) - stack trace available
logger.log(Level.ERROR, String msg) – no stack trace here

Any exception that occurs during an exit call, for example while calling SQL, a web service,
or a message queue server.

An application server exception is a code-logged message outside the context of a business
transaction.

There is not a one-to-one correspondence between the number of errors and the number of
exceptions. For example, a business transaction may experience a single code 500 error in which
several exceptions were logged as the transaction passed through multiple tiers.

You can configure the types of errors that AppDynamics detects as well as the types of exceptions
to ignore. See .Configure Error Detection

See the Supported Environments and Versions, such as Supported Environments and Versions
 document for your app agent to determine if the loggers you use are recognized byfor Java

default by AppDynamics. If you expect to see errors from a custom logger you first need to
configure AppDynamics to recognize the logs. See .Custom Logger Definitions
To Troubleshoot Error Transactions

1. Click  in the left navigation panel.Troubleshoot -> Errors

The error viewer opens.

2. Click the   tab if it is not already selected.Error Transactions

3. From the time range drop-down menu select the time range for
which you want to view information about error transactions.

http://docs.appdynamics.com/display/PRO14S/Configure+Error+Detection
http://docs.appdynamics.com/display/PRO14S/Supported+Environments+and+Versions+for+Java
http://docs.appdynamics.com/display/PRO14S/Supported+Environments+and+Versions+for+Java
http://docs.appdynamics.com/display/PRO14S/Configure+Error+Detection#ConfigureErrorDetection-CustomLoggerDefinitions


Copyright © AppDynamics 2012-2014 Page 15

A graph of the error transactions displays at the top of the viewer.
You can get an exact count of the errors per minute at a particular
point in time by hovering with your pointing device on the line in the
graph.

To the right of the graph is a summary of the load and the error
transactions.

Check the Plot check box if you want the graph at the top of the
viewer to show the load over the selected time period. Clear this
check box is clear, if you want the graph to show only the error
transactions .

4. The error transaction snapshots are listed in the lower part of the
viewer. To filter this list click  and select the filterShow Filters
criteria.

5. To examine the root cause of an error, select the snapshot from
the list and click . See View Transaction Snapshot Transaction

 for information about examining snapshots.Snapshots

6. To identify the most expensive calls or queries, select a snapshot
from the list and click   and then click Analyze Identify the most

.expensive calls / SQL statements in a group of snapshots

The Most Expensive Methods / SQL Statements viewer opens.

7. In the lower panel click the  tab to view theExpensive Methods
methods with their total and average execution times and call
counts. Click the   tab to view the queries with theirExpensive SQL
counts and execution times.

This two-minute interactive
video traces the typical steps
of identifying the cause of an
error in your application.

To Troubleshoot Exceptions

1. Click  in the left navigation panel.Troubleshoot -> Errors

2. Click the  tab if it is not already selected.Exceptions

The total exception count, HTTP Error Codes and Error Page Redirects for the selected time

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
https://appdynamics-static.com/education/video/troubleshootingErrors/story.html
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range are reported in the upper panel. You can get an exact count of the errors per minute at a
particular point in time by hovering with your pointing device on the line in the graphs.

The exceptions list is displayed in the lower panel.

To filter the exception list, enter the filter term in the search text box on the upper right.  
For example, to see only HTTP errors - and to see the breakdown of HTTP errors by code
type - type HTTP in the search box.  The list of HTTP errors by code is displayed.
To see only errors with performance data, clear the Show Exceptions with 0 count
checkbox.

3. To view details of a particular exception, select the exception the list in the lower panel and click
.View Details

The exception detail window displays.

4. To view transaction snapshots for an exception:

a. In the exception detail window, click the  tab.Occurrences of this Exception

b. Select a snapshot from the list.

c. Click .View Details

d. in the snapshot flow map that displays, click . See .Drill Down Transaction Snapshots

5. To view a stack trace for an exception:

a. In the exception detail window, click the  tab.Stack Traces for this Exception

b. Click an exception in the left panel.

The right panel displays the stack trace for the selected exception.

Learn More

Troubleshoot Errors 
Configure Error Detection
Transaction Snapshots

Troubleshoot a Problem that Happened in the Past

Set the Time Range
Drill Down to the Problem
Changing Other Time Windows
Baselines
Learn More

It's not uncommon to want to investigate an issue that occurred in the past.  For example, over the
weekend there was a spike in stalled requests.  The issue resolved, so there was no emergency,
but, come Monday morning, you want to look back at what happened, and what was going on at
the time in general in your system.  

Set the Time Range

Use the Time Range dropdown menu to set the display to cover the timeframe needed.

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://appdynamo.wistia.com/medias/lr63udmauo
http://docs.appdynamics.com/display/PRO14S/Configure+Error+Detection
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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1.  
2.  

3.  

4.  

Drill Down to the Problem

Click Troubleshoot->Slow Response Times
Select the Slow Transactions tab.

Drag your mouse to select the the range where the problem occurred - in the example, the
spike in stalls. 
A Time Range popup appears.

Select Drill Down Into Selected Time Range.
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4.  

5.  

6.  

The Time Range Drill Down Workbench appears.

Select the Transaction Snapshots tab and the Slow and Error Transactions tab.  
Those stalled transactions all seem to be for the Fetch Catalog business transaction.  
Click the Exe Time column to find the very slowest of the stalled transactions and click View
Transaction Snapshot.
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6.  

7.  

The Transaction Snapshot Flow Map appears.

Click Drill Down to see the Call Drill Down window, including the call graph.

A slow database call was at the root of the problem.

Changing Other Time Windows

You can use the mouse select time range method in many places throughout the UI.  For example,
in KPI listings in various dashboards:

Drill into Load from the top level dashboard
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Select snapshots occurring during a particular range in End User Response Time from the
Web EUM dashboard

You can even use it in the Metric Browser:

Baselines
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Whether or not some event in the past has been defined as an issue often depends on the baselin
being used in the evaluation of that event.  To understand how baselines work and what impacte 

they can have, see  .Behavior Learning and Anomaly Detection

Learn More

KPI Graphs
Rapid Troubleshooting

 

 

 

 

Diagnostic Sessions
Triggering a Diagnostic Session

On-demand Diagnostic Sessions
To Start a Diagnostic Session for a Business Transaction Manually

Automatic Diagnostic Sessions For Slow and Error Transactions
To Configure Diagnostic Session Thresholds

Accessing a Diagnostic Session
To View a Diagnostic Session

Learn More

This topic explains what a diagnostic session is and how to capture diagnostic session on a
transaction.

A diagnostic session captures detailed data about the processing of a transaction as transaction
snapshots over a defined period of time. This data includes full call graphs.

Diagnostic sessions can be triggered manually through the user interface or configured to start
automatically when thresholds for slow, stalled, or error transactions are reached. If the diagnostic
session is triggered manually, the diagnostic session collects snapshots on all the nodes that the
selected business transaction passes through. If the diagnostic session is triggered to start
automatically, the diagnostics session collects snapshots on the triggering node.

Triggering a Diagnostic Session

You can manually trigger a diagnostic session when you need one or configure them to start up
automatically.

On-demand Diagnostic Sessions

On-demand diagnostic sessions must be started manually.

To Start a Diagnostic Session for a Business Transaction Manually

1. Display the dashboard for the business transaction that you want to analyze. See Business
.Transactions List

http://docs.appdynamics.com/display/PRO14S/Behavior+Learning+and+Anomaly+Detection
http://docs.appdynamics.com/display/PRO14S/KPI+Graphs
http://docs.appdynamics.com/display/PRO14S/Business+Transactions+List
http://docs.appdynamics.com/display/PRO14S/Business+Transactions+List
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2. Click  or right-click on the selected business transactionActions -> Start Diagnostic Session
and then click .Start Diagnostic Session

3. Specify the snapshot collection duration at the bottom of the Start Diagnostic Session window.

AppDynamics will start collecting transaction snapshots for that business transaction.

Automatic Diagnostic Sessions For Slow and Error Transactions

AppDynamics provides default thresholds to detect slow, very slow, stalled and error transactions.
You can configure settings for triggering diagnostic sessions for these transactions.

To Configure Diagnostic Session Thresholds

1. In the left navigation pane, click .Configure -> Slow Transaction Thresholds

2. For configuring thresholds for business transactions click the  taUser Transaction Thresholds
b. For thresholds for background tasks, click the  tab.Background Tasks Thresholds

3. In the thresholds tree list, select the scope of the threshold, either:

Default Thresholds
or
Individual Transaction Thresholds

4. In the right panel configure thresholds for when diagnostic sessions will be started.

Here you can set a trigger based on the percentage of requests that exceed the Slow Request
threshold. For performance reasons you may not want to trigger a diagnostic session each time a
threshold is exceeded.

5. Configure diagnostic session duration and collection frequency. This includes:

Number of snapshots to collect over a specified time period
Number of unsuccessful attempts per minute
Wait period between sessions

For performance reasons you want to limit the duration and frequency of diagnostic sessions to
the minimum required time to obtain the maximum amount of information for troubleshooting
purposes. 

When there are ongoing performance problems you do not want a diagnostic session to run
continuously.  You can set a wait period between sessions and increase the time as needed.
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Accessing a Diagnostic Session

You can access a diagnostic session from the transaction snapshot list.

To View a Diagnostic Session

1. Navigate to the transaction snapshot list.
See .To View Transaction Snapshots

2. Select a transaction snapshot from the list and either double-click it or click .View Dashboard

3. Click the  tab.Diagnostic Sessions

4. From the list select a diagnostic sessions and click .View Diagnostic Session
From there you can double-click a transaction snapshot to dive deeper.

Learn More

Transaction Snapshots
Actions
Diagnostic Actions

Call Graphs

Call Graphs
To view call graphs
To Filter and Search for a Class Name in a Call Graph

Diagnosing the Root Cause of Problems Using Call Graphs
Troubleshoot Problems using Call Graphs
Understanding Data Captured in Call Graphs

Class/Method Names and Time spent
External Calls Invoked by a Method
Viewing Call Graph Hot Spots

Advanced Options
Classes displayed in the call graphs
Packages and Namespaces excluded from the call graph
Configure instrumentation

Learn More

This topic describes call graphs for code-level diagnostics.

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots#TransactionSnapshots-ToViewTransactionSnapshots
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Actions
http://docs.appdynamics.com/display/PRO14S/Diagnostic+Actions
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Call Graphs

A call graph lists the methods in a call stack and provides information about each call. Call graphs
help you diagnose performance issues and optimize the flow of a complex business transaction.

AppDynamics call graphs provide the following information:

Call information: This includes the total execution time, the node name for the call graph,
and the time stamp for the start of execution.

Method execution sequence: An easily readable method execution sequence with the
class names and the method names of each method.

Application component information: Application component information such as
Servlet names, Struts Action classes, EJB names, Spring Bean IDs and proxies,
message listeners, etc. POJOs are represented by class name, unless the POJO is a
special type of component such as a struts action invoker. The class name is available
for all call graph elements including those having logical class names.
Code line number: The line number of the element in the source code, if available.

Time distribution for each method: The time distribution for each method along with the
percentage of the total time in the call graph.

Exit call information: Links to more information about exit calls such as  JDBC, JMS, and
Web Services.

Application component summary information: Summary information for each element in
the call graph.

In addition you can:

Filter the call graph list using criteria such as application components, time, or all or part of
the name.

Select an element of the list and set it as the root of the list to drill down into large call
graphs more efficiently.

Export the call graph to PDF to share the information with other team members.
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 There are two kinds of call graphs: full and partial.  Full call graphs capture the entire call
sequence and are captured periodically for general monitoring purposes.  Partial call graphs
capture the call sequence from the point at which the call sequence has been determined to be
slow or have errors, and thus may not include the initial steps in the sequence.

To view call graphs

1. From a dashboard, click the  tab.   Transaction Snapshots

2. Do one of the following:

Click  to see all snapshots.All Snapshots
Click  to see snapshots for slow and error transactions.Slow and Error Transactions
Click  to see snapshots collected periodically.Periodic Collection

2. Select a particular transaction snapshot and click .View Transaction Snapshot

3. Click the  icon to see the call graph for the snapshot.Drill Down
By default the originating call graph in a business transaction,  generated by the entry point on the
entry point tier, displays.

To Filter and Search for a Class Name in a Call Graph

The call graph is displayed when you click on the  option on the  snapshot. You candrill down
filter and search for a particular class name on the call graph. To do this, use the search box
available on the left side of the call graph.

Diagnosing the Root Cause of Problems Using Call Graphs

Troubleshoot Problems using Call Graphs

You can use call graphs to troubleshoot the problems in the flow
map. Drill down into each tier using the  option. If there isDrill Down
only one invocation, AppDynamics displays the call graph.

When there are multiple invocations for that tier which participated in
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the transaction, the  menu displays a list of allAction -> Drill Down
call graphs for the node. Each call graph represents a call into the
node. For example, if JVM A makes two remote calls to JVM B, then
JVM B will have two call graphs.

Understanding Data Captured in Call Graphs

Class/Method Names and Time spent

Call graphs represent the sequence of execution of code on the
application server. Each row represents a method call and the tree
represents the execution sequence.

The total time spent in the call graph is displayed on the top left
corner of the call graph.

The Time (ms) column in the call graph shows the time spent in each
method.

External Calls Invoked by a Method

If a method invokes external calls outside of the app server, such as
a JDBC query or a Web Service call, there is a link to the call in the
call graph.

The following example shows the details of a JDBC call that include
the query, the execution time of the query, the number of times that
the application code iterated over the query results (ResultSet
Count) and the time in milliseconds that the application code spent
iterating over the results (ResultSet Time).

If the detail screen has a Drill Down link, you can get a call graph for
the calls downstream from the original call.

Viewing Call Graph Hot Spots

The most expensive methods are listed in the Hot Spots section of
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the transaction snapshot.

Advanced Options

Classes displayed in the call graphs

The sequence of Java method invocations in a call graph can
include hundreds of classes. These classes are categorized as:

Application classes

AppServer/Container/Middleware classes (For example:
Tomcat runtime classes, Websphere runtime classes, etc.)

JDBC Driver/External infrastructure library classes (For
example: Oracle Driver classes, Axis Web Service runtime
classes, Hibernate classes, etc.)

Third party utility libraries (For example: Apache commons
libraries)

Java/J2EE core libraries

Adding all of these classes together in a call graph is
counterproductive for troubleshooting. The only mandatory classes
required, are the classes from first category- the Application classes.
You might require the other classes only in certain situations. To
make the call graph more readable and to avoid the overhead of
processing the timing information for all the non-application classes,
other classes are not shown in the call graph.

Packages and Namespaces excluded from the call graph

A call graph can have a list of packages (Java) or namespaces
(.NET) that are not displayed. To access this list, click on the
message for "Some packages/namespaces have been excluded
from the Call graph" message.
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The PHP and Node.js agents do not support call graph exclusion.

Configure instrumentation

You can right-click on any item in a call graph and select Configure
.Instrumentation for this Class/Method

The Configure Instrumentation window presents a drop-down menu
form which you can select the type of configuration that you want to
create for the method.
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This short interactive video
traces the typical steps of
identifying the cause of
communication issues
between tiers in your
application.

Learn More

Configure Call Graphs
Configure Code Metric Information Points
Configure Custom Exit Points for Java
Configure and Use Object Instance Tracking for Java
Configure Memory Monitoring for Java
POJO Entry Points
Configure Data Collectors
Tracing Multi-Threaded Transactions (Java)

Configure Call Graphs

Call Graph Settings
To access call graph configuration screens

Call Graph Granularity
Packages or Namespaces to Exclude from Call Graphs

To exclude specific packages or namespaces from call graphs
To Include Specific Sub-packages (Sub-namespaces) or Classes from the
Excluded Packages

SQL Capture Settings
To Configure SQL Bind Variables

Slow Transaction Snapshot Collection
Aggressive Slow Snapshot Collection (Java only)

To Enable / Disable Aggressive Slow Snapshot Collection
Learn More

This topic describes how to configure call graphs.

Call Graph Settings

The Call Graph Settings window lets you configure thresholds that affect performance, which
packages or namespaces to include in call graphs, and how much detail about SQL statements to
capture.

https://education.appdynamics.com/video/troubleshootingTheFronToMidTier/story.html
http://docs.appdynamics.com/display/PRO14S/Configure+Code+Metric+Information+Points
http://docs.appdynamics.com/display/PRO14S/Configure+Custom+Exit+Points+for+Java
http://docs.appdynamics.com/display/PRO14S/Configure+and+Use+Object+Instance+Tracking+for+Java
http://docs.appdynamics.com/display/PRO14S/Configure+Memory+Monitoring+for+Java
http://docs.appdynamics.com/display/PRO14S/POJO+Entry+Points
http://docs.appdynamics.com/display/PRO14S/Configure+Data+Collectors
http://docs.appdynamics.com/pages/createpage.action?spaceKey=PRO14S&title=Trace+Multi-Threaded+Transactions+for+Java&linkCreation=true&fromPageId=20187299
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To access call graph configuration screens

1. In the left navigation pane, click .Configure -> Instrumentation

2. Click the  tab.Call Graph Settings

3. Click the  tab for the framework you are configuring.sub

Whenever you create or modify a call graph setting in these screens, click the Save Call Graph
 button to save your configuration.Settings

Call Graph Granularity

You can control the granularity for call-graphs using following settings:

Control granularity for Methods: To ensure low performance overhead, choose a
threshold in milliseconds for method execution time. Methods taking less than the time
specified here will be filtered out of the call graphs.

Control granularity for SQL calls: You can also specify a threshold for SQL queries. SQL
queries taking more than the specified time in milliseconds will be filtered out of the
call-graphs. Also see .App Agent for Java Performance Tuning

Packages or Namespaces to Exclude from Call Graphs

A call graph can potentially contain hundreds of methods. You can exclude packages for Java or
namespaces  for .NET with classes that you do not want to monitor.

For Java, some packages are excluded by default. These are visible in the Excluded Packages
list. The packages that are excluded by default cannot be removed. However, you can include a
particular sub-package from an excluded package. See To Include Specific Sub-packages

.(Sub-namespaces) or Classes from the Excluded Packages

To exclude specific packages or namespaces from call graphs

1. Click  (Java) or  (.NET).Add Custom Package Exclude Add Custom Namespace Exclude

2. Enter the name and description of the package or namespace to exclude.

3. Click .Add

To Include Specific Sub-packages (Sub-namespaces) or Classes from the Excluded Packages

1. Click  (Java) or  (.NEAdd Always Show Package/Class Add Always Show Namespace/Class
T).

2. Specify the subpackage/class or namespace/class and a description to include in the call graph
at all times.

3. Click .Add

SQL Capture Settings

Often the SQL Calls section does not display the raw values in a SQL query, as shown in the
following query:

INSERT INTO ORDERREQUEST ( ITEM_ID, NOTES ) VALUES ( ?, ? )

http://docs.appdynamics.com/display/PRO14S/App+Agent+for+Java+Performance+Tuning
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Replacing the literals in a query with parameter markers in this way is called normalizing the
query.

Normalizing a query prevents display of sensitive data, such as social security numbers or credit
card numbers, which are potential query parameters. Normalizing queries also helps to organize
SQL data by flattening the parameter values for the query so that the statistics from different
executions of the query can be aggregated and compared against one another.

However, during troubleshooting, you may want to display the values of the bind variables.

Note that SQL passed in as a string is not redacted.

To Configure SQL Bind Variables

1. In the  tab, scroll down to the SQL Capture Settings section.Call Graph Settings
2. Select one of the following:

Capture Raw SQL: Select this option to see raw SQL data (this captures raw SQL data
along with the parameter values). Raw SQL data includes prepared statement bind variables
or raw statements. By default, the private SQL data and queries that take less than 10 ms
are not captured.

Filter Parameter values: Select this option to filter certain parameter values from the
captured SQL.

3. Click .Save Call Graph Settings

Slow Transaction Snapshot Collection

AppDynamics captures the full execution path of a request after its execution time exceeds the
business transaction threshold for slow requests. Before a request becomes problematic (slow,
stalled or error), AppDynamics captures partial call graphs that do not show the invocation stack
from before the request started to slow.

Aggressive Slow Snapshot Collection (Java only)

For Java only, you can configure more aggressive snapshot collection to capture the full execution
path of requests before thresholds are crossed.

By default the agent disables aggressive snapshot collection to minimize overhead. Enable it when
you start to experience performance problems in order to diagnose the root cause.

This configuration affects snapshot collection at the application level. You can also enable and
disable this feature at the node level using the enable-hotspot-snapshots node property. For
information about setting node properties see .App Agent Node Properties

To Enable / Disable Aggressive Slow Snapshot Collection

1. Select the application for which you want to enable or disable aggressive snapshot collection.
2. In the left navigation panel click .Configure -> Instrumentation
3. Click the  tab. and then the  sub-tab.Call Graph Settings Java Call Graph Settings

http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties
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4. At the bottom of the Call Graph Settings screen, in the Slow Transaction Snapshot Collection
section, check the Enable Aggressive Slow Snapshot Collection checkbox to enable aggressive
collection. Clear the checkbox to disable aggressive collection.
5. Click .Save Call Graph Settings

Learn More

Call Graphs
App Agent for Java Performance Tuning
Transaction Snapshots

Analyze

AppDynamics provides tools to help you analyze patterns and discover relationships between
different metrics and performance data over time. See:

Scalability Analysis
Scalability Analysis Comparisons

To access Scalability Analysis
To use scalability data

Learn More

Scalability problems in a distributed environment can cause remote communication overhead.
Examples of scalability problems include:

Increased inter-tier time when tiers are newly separated
Increased inter-tier time in conjunction with chattiness
Over-sized payloads with network saturation

Scalability Analysis Comparisons

You can compare:

Response Time vs Application Load
You can compare average response time versus calls per minute for a business application,
a business transaction, a tier, or a node.

CPU Utilization vs Application Load
You can compare CPU % usage versus calls per minute for a business application, a tier, or
a node. 
To compare CPU % usage, a standalone or embedded machine agent must be installed on
the node machine.

The following graph shows Response Time vs Load at the application level for the past three days.

http://docs.appdynamics.com/display/PRO14S/App+Agent+for+Java+Performance+Tuning
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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To access Scalability Analysis

In the left navigation pane for an application click .Analyze -> Scalability Analysis

To use scalability data

1. Select the time range to be covered by the analysis from the  menu.Time Range
Modifying the time range in this window does not modify the time range settings in other parts of
the UI.

2. Click either the  tab or the  tab, dependingResponse Time vs Load CPU Utilization vs Load
on which analysis you want to perform.

3. In the left panel of the scalability viewer either:

Select Application for analysis at the application level.

or

Navigate to the business transaction, tier, or node that you want to analyze.

4. Browse the graph and explore:

You can change between a scatter plot view and a side-by-side graph view.

You can toggle the Best Fit Line in the scatter plot view. The Best Fit Line is calculated using
the Quadratic Least Squares algorithm.

You can hover over data points to view metrics at particular times.

Double-click on a data point to open its metrics in the .Metric Browser

http://docs.appdynamics.com/display/PRO14S/Time+Ranges
http://docs.appdynamics.com/display/PRO14S/Metric+Browser
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Click the tab header  or  to updateAnalyze Response Time Vs Load Analyze CPU vs Load
the graph.

You can export the data as a comma-separated values file:

Learn More

Infrastructure Metrics
Metric Browser

Correlation Analysis
To perform correlation analysis between two metrics

Learn More

Correlation analysis lets you compare two metrics on different axes to see how one metric
correlates with the other.

To perform correlation analysis between two metrics

1. In the left navigation pane, click .Analyze -> Correlation Analysis

2. Click .Select X Axis Metric

3. From the metric browser navigate to the metric that you want to graph on the X axis and
double-click the metric.

4. Click .Select Y Axis Metric

3. From the metric browser navigate to the metric that you want to graph on the Y axis and
double-click the metric.

The graph is displayed when metrics for both the axes are selected.

http://docs.appdynamics.com/display/PRO14S/Infrastructure+Metrics
http://docs.appdynamics.com/display/PRO14S/Metric+Browser
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Hover over one or more of the data points to view their metrics at particular times.

Learn More

Metric Browser

Compare Releases
Entities to Compare
Metrics to Compare

To Compare Releases
Learn More

You can compare metrics for two different time periods on a split screen.

This feature is particularly useful for comparing different versions of a release.

Entities to Compare

You can compare summary metrics:

for the entire application

http://docs.appdynamics.com/display/PRO14S/Metric+Browser
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for a specific business transaction

for a specific tier

for a specific node

Metrics to Compare

The metrics you can compare are:

Summary Key Performance Indicators (KPIs)
Displays the KPI summaries from the dashboards for the selected entity
(application/business transaction/tier/node).

Transaction Snapshots
Displays the transaction snapshots for the selected entity.

Graphical Flow
Displays flow graphs for the selected entity.

KPI Trend Graphs
Displays the KPI summaries from the dashboards for the selected entity
(application/business transaction/tier/node).

Select which sets of metrics you want to compare from the View drop-down menu.

To Compare Releases

1. In the left navigation pane, click  .Analyze -> Compare Releases

2. Set the time ranges to compare from the Time Range drop-down menus in both panes.

3. Select the entities to compare in the Select What to Compare panel.

4. Select the metrics that you want to compare from the View drop-down menu.

5. Click .Compare

Whenever you change the entities or the metrics, click  to refresh the display.Compare

Learn More

Dashboards
Transaction Snapshots
Time Ranges

http://docs.appdynamics.com/display/PRO14S/Dashboards
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Time+Ranges
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Troubleshoot Health Rule Violations
Health and Health Rules
Troubleshoot Heath Rule Violations

To find all health rule violations
To troubleshoot a health rule violation
To see health rule status in the UI

Learn More

Health and Health Rules

"Health" throughout the AppDynamics UI refers to the extent to which the component being
monitored is operating within the acceptable limits defined by health rules. Health rules allow you
to automate pro-active monitoring and problem mediation in your managed environment. By
default, AppDynamics provides a set of basic health rules, which you can extend, add to, or
remove as your needs dictate.

A health rule violation exists when the conditions that define the rule are true. For example, you
might have defined a health rule condition that states that a CPU%Busy rate of more than 90% on
any node is a critical condition. If the rate on a node then goes over 90%, the health rule is said to
"violate" and the AppDynamics UI displays a notification of that violation.

Because there is a set of default health rules, you may see health rule violations reported for your
application even if you have not set up your own health rules. If you see violations reported for the
APPDYNAMICS_DEFAULT_TXT business transaction, these are for default health rule violations
in the All Other Traffic business transaction. If you are not interested in monitoring these business
transactions, you may want to examine your business transaction setup. See Organizing Traffic as

.Business Transactions

For general information about health rules, see . For information on setting up yourHealth Rules
own health rules, see .Configure Health Rules

Troubleshoot Heath Rule Violations

To start troubleshooting health rule violations, you can:

Get a list of all the health rule violations by clicking Troubleshoot -> Health Rule
.Violations

Click on a particular health rule violation you see .displayed in the UI

You can access the list of health rule violations in your application for the selected time range.

To find all health rule violations

1. In the left navigation pane, click .Troubleshoot -> Health Rule Violations
The list of health violations displays.

http://docs.appdynamics.com/display/PRO14S/Organizing+Traffic+as+Business+Transactions
http://docs.appdynamics.com/display/PRO14S/Organizing+Traffic+as+Business+Transactions
http://docs.appdynamics.com/display/PRO14S/Health+Rules
http://docs.appdynamics.com/display/PRO14S/Configure+Health+Rules
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2. Select  or View All Health Rule Violations in the Time Range View Only Health Rule
.Violations Open Now

It is possible that health rule violations that were reported are no longer open because remedial
action has been taken or performance has improved on its own.

3. To see the filters click . To hide them click .Show Filters Hide Filters

With the filters showing in the left filters panel you can select the health rule violations that you
want to troubleshoot. You can view all health rule violations or expand the nodes in the tree to
select by health rule type (such as business transaction health rules or node health rules) or
affected entity (such as business transaction, tier or node).
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You can filter health rule violations by entering the name of the health rule in the search field on
the upper right.

The health rule violations are displayed in the right panel, with their status, description, start time,
end time and duration (if ended), and the affected entity.

To troubleshoot a health rule violation

Once you have located the violation you are interested in, you can get more information in three
ways:

To see the health rule definition that was violated for a specific violation, find the health rule
violation in the list and in the Health Rule column, click the link to the health rule
configuration. The Edit Health Rule window for the specific definition appears.
To see the dashboard for the entity, such as a business transaction or a node, affected by
the violation, click the link to the entity in the Affects column. The Transaction Flow Map
appears.
To troubleshoot a specific health rule violation, select the health rule violation row from the
list and click   in the top bar.Health Rule Violation Details

The Health Rule Violation Event window displays a summary of the violation and any actions that
were executed to respond to it.
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You can click the  in the details window to viewView Dashboard During Health Rule Violation
the dashboard at the time the violation occurred. The time range in this and all other dashboards is
set to the time range of the health rule violation. From the dashboard you can get an overall
picture of the application at the time of the violation. If you select the Transaction Snapshots tab
you get a list of relevant snapshots which allows you to drill down to the root cause of the problem.
See  for more information.Transaction Snapshots

To see health rule status in the UI

Across the UI, health rule status is color-coded: green is healthy; yellow/orange is a warning
condition; and red is a critical condition. If you see a health rule violation reported in the UI, you
can click it to get more information about the violation.  

Here are the health summary bars on the dashboards:

There is a health column in the business transaction list:

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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In the Events panel on the dashboards, health violations are displayed as events.

To see a summary of the violation, click a health rule violation from the Events list, then select the
violation you are interested in from the list that appears. Click   in the top barView Event Details
and the Health Rule Violation Started window appears.  It displays detailed information and a link
to the appropriate dashboard at the time of the violation.  If any Policy actions were executed in
response to the violation, they are also displayed.

Learn More

Health Rules

http://docs.appdynamics.com/display/PRO14S/Health+Rules
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Configure Health Rules
Organizing Traffic as Business Transactions
Policies
Alert and Respond
Transaction Snapshots

Troubleshoot Java Application Problems
Troubleshoot Slow Response Times for Java

How Do You Know Response Time is Slow?
Troubleshooting Steps

Step 1 - Slow or stalled business transactions?
Step 2 - Slow DB or remote service calls?
Step 3 - Affects 1 or more nodes?
Step 4 - Backend problem?
Step 5 - CPU saturated?
Step 6 - Significant garbage collection activity?
Step 7 - Memory leak?
Step 8 - Resource leak?
None of the above?

How Do You Know Response Time is Slow?

There are many ways you can learn that your application's response time is slow:

You received an email or SMS alert from AppDynamics (see ). The alertAlert and Respond
provides details about the problem that triggered the alert. If the problem is related to slow
response time, start troubleshooting at  .Step 1
Someone reported a problem such as "it's taking a long time to check out" or "the app timed
out when I tried to add an item to the cart."
The problem is slow response time related to one or more business transactions. Start
troubleshooting at  .Step 1
A custom dashboard shows a problem.  If the problem is related to slow response time, start
troubleshooting at  .Step 1
You are looking at the Application Dashboard for a business application, shown below:

http://docs.appdynamics.com/display/PRO14S/Configure+Health+Rules
http://docs.appdynamics.com/display/PRO14S/Organizing+Traffic+as+Business+Transactions
http://docs.appdynamics.com/display/PRO14S/Policies
http://docs.appdynamics.com/display/PRO14S/Alert+and+Respond
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Alert+and+Respond
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1.  

2.  

3.  

4.  

Look at the traffic flow lines in the flow map, the Business Transaction Health pane, the
Transaction Scorecard pane, and the Response Time graph. If you see problems (yellow or
red lines, spikes in response time), the problem is slow response time, and is probably
related to your AppDynamics business application. Start troubleshooting at  .Step 1
Look at the Tier icons in the flow map. If you see yellow or red, you have a problem with one
or more nodes, which may or may not result in slow response time. Start troubleshooting at 

.Step 3
Look at the Events pane. If you see red or yellow, the problem reflects a change in
application state that is of potential interest, which may or may not result in slow response
time. See .Tutorial for Java - Troubleshooting using Events
Look at the Server Health pane. If you see red or yellow, the problem reflects a server health
rule violation, which may or may not result in slow response time. See Tutorial for Java -

.Server Health

Need more help?

Application Dashboard
Flow Maps

Troubleshooting Steps

The following steps help you determine whether your problem is related to your business
application or to your hardware or software infrastructure. Each step shows you how to display
detailed information to help you pinpoint the source of the problem and quickly resolve it.

http://docs.appdynamics.com/display/PRO14S/Tutorial+for+Java+-+Server+Health
http://docs.appdynamics.com/display/PRO14S/Tutorial+for+Java+-+Server+Health
http://docs.appdynamics.com/display/PRO14S/Application+Dashboard
http://docs.appdynamics.com/display/PRO14S/Flow+Maps
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Step 1 -
Slow or
stalled
business
transaction
s?

Are there any slow or stalled business transactions?
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How do I know?

How do I know if business transactions are slow or
stalled?

1. Click Troubleshoot -> Slow Response Times
You can also access this information from tabs in the
various dashboards.

2. Click the  tab if it is not selected.Slow Transactions

In the upper pane AppDynamics displays a graph of
the slow, very slow, and stalled transactions for the
time period specified in the Time Range drop-down
menu. If the load is not displayed, you can click the
Plot Load checkbox at the upper right to see the load.
In the lower pane AppDynamics displays the
transaction snapshots for slow, very slow, and stalled
transactions.

If you see one or more slow transaction snapshots on this
page, the answer to this question is Yes. Otherwise, the
answer is No.

No – Go to .Step 2

Yes – You have one or more slow or stalled transactions, and
need to drill down to find the root cause.
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1.  

2.  

3.  

In the lower pane of the Slow Transactions tab, click the
Exe Time column to sort the transactions from slowest to
fastest.
Select a snapshot from the list and click View
Transaction Snapshot. You see the Transaction Flow
Map. Choose the Flow Map tab if it is not already
selected.

Click a Drill Down icon to display a call graph for a
problematic part of the transaction. Once you are in the
call graph you can look for methods that have a
significant response time. In this example, the
executeQuery method is responsible for 54.5% of
response time. 
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4.  Click the Information icon in the right column to see more
details. Provide this information to the personnel
responsible for addressing this issue.

If there are multiple slow or stalled transactions, repeat this
step until you have resolved them all. However, there may
be additional problems you haven't resolved. Continue to S

.tep 2

Need more help?

Transaction Snapshots

Step 2 -
Slow DB or
remote
service
calls?

Is there one or more slow DB or remote service call?

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots


Copyright © AppDynamics 2012-2014 Page 48

How do I know?

How do I know if I have slow DB or remote service calls?

1. Click , then clickTroubleshoot -> Slow Response Times
the  tab if it is notSlowest DB & Remote Service Calls
selected.

If you see one or more slow calls on this page, the answer to
this question is Yes. Otherwise, the answer is No.

No – Go to .Step 3

Yes – You have one or more slow DB or remote service calls,
and need to drill down to find the root cause.
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1.  

2.  

3.  

4.  

5.  

In the Call Type panel select the type of call for which you
want to see information, or select All Calls.
Sort by Average Time per Call to display the slowest calls
at the top of the list.
To see transaction snapshots for the business
transaction that is correlated with a slow call, you can:

Click the  link in the right columnView Snapshots
to display correlated snapshots in a new window.
Select the call and click the Correlated Snapshots
tab in the lower panel to display correlated
snapshots at the bottom of the screen.

Select a snapshot from the list and click View
Transaction Snapshot. Choose the Flow Map tab if it is
not already selected, then click a Drill Down icon to
display a call graph for a problematic part of the
transaction.

Once you are in the call graph you can look for methods
that have a significant response time. In this example, an
Oracle query is responsible for 99.7% of response time.
Provide this information to the personnel responsible for
addressing this issue.
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If there are multiple slow calls, repeat this step until you have
resolved them all. However, there may be additional problems
you haven't resolved. If any of the tier icons on the flow map
show yellow or red, continue to  . Otherwise, you haveStep 3
isolated the problem and don't need to continue with the rest of
the steps below.

Need more help?

Business Transaction Dashboard
Business Transaction Monitoring
Business Transactions List
Transaction Snapshots

Step 3 -
Affects 1 or
more
nodes?

Is the problem affecting all nodes in the slow tier?   
How do I know?

How do I know if the problem is affecting all nodes?

In the Application or Tier Flow Map, click the number
that represents how many nodes are in the tier. This
provides a quick overview of the health of each node
in the tier. The small circle icon indicates whether the
server is up with the agent reporting, and the larger
circle icon indicates Health Rule violation status.

If all the nodes are yellow or red, the answer to this
question is Yes. Otherwise, the answer is No.

Yes – Go to .Step 4

No – The problem is either in the node's hardware or in the
way the software is configured on the node. (Because only
one node is affected, the problem is probably not related to
the code itself.)

http://docs.appdynamics.com/display/PRO14S/Business+Transaction+Dashboard
http://docs.appdynamics.com/display/PRO14S/Business+Transaction+Monitoring
http://docs.appdynamics.com/display/PRO14S/Business+Transactions+List
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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In the left navigation pane, click Servers -> App Servers
 to display the-> <slow tier> -> <problematic node>

Node Dashboard (flow map).

Click the Dashboard tab to get a view of the overall
health of the node.
Click the Hardware tab; if the problem is
hardware-related, contact your IT department.
Click the Memory tab; sort on various column headings to
determine if you need to add memory to the node,
configure additional memory for the application, or take
some other corrective action.

You have isolated the problem and don't need to continue
with the rest of the steps below.

Need more help?

Node Dashboard

Step 4 -
Backend
problem?

Are the nodes in the slow tier linked to a backend (database or
other remote service) that might be causing your problem? 

http://docs.appdynamics.com/display/PRO14S/Node+Dashboard
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How do I know?

How do I know if the nodes are linked to a backend
(database or other remote service) that might be causing
my problem?

Display the Tier Flow Map. If any nodes are linked to a
backend, links to those backends are displayed in the
flow map.

If a backend or the line connecting to a backend is
yellow or red, the answer to this question is Yes.
Otherwise, the answer is No.

No – Go to .Step 5

Yes –

Click the line connecting to the backend to see an
information window about the backend. (The
contents of the information window vary depending
on the type of backend.) Use the various tabs to
find the source of the issue, or contact the team
responsible for that backend.
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If the backend is a database, right-click the database icon.
You have a number of options that let you see the
dashboard, drill down, etc. If you have AppDynamics for
Databases, choose Link to AppDynamics for Databases.
You can use AppDynamics for Databases to diagnose and
resolve any backend issues, or work with your internal
DBAs to troubleshoot the database, which is not
instrumented in AppDynamics.

You have isolated the problem and don't need to continue
with the rest of the steps below.

Need more help?

Backend Monitoring
Configure Backend Detection for Java
AppDynamics for Databases

Step 5 -
CPU
saturated?

http://docs.appdynamics.com/display/PRO14S/Backend+Monitoring
http://docs.appdynamics.com/display/PRO14S/Configure+Backend+Detection+for+Java
http://docs.appdynamics.com/display/ADDB/AppDynamics+for+Databases
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1.  
2.  
3.  

Is the CPU of the JVM saturated?
How do I know?

How do I know if the CPU of the JVM is saturated?

Display the Tier Flow Map.
Click the Nodes tab, and then click the Hardware tab.
Sort by CPU % (current). .Show me how

If the CPU % is 90 or higher, the answer to this
question is Yes. Otherwise, the answer is No.

Yes – Go to .Step 6

No – The issue is probably related to a custom
implementation your organization has developed. Take
snapshots of the affected tier or node(s) and work with
internal developers to resolve the issue.

You have isolated the problem and don't need to continue
with the rest of the steps below.

Need more help?

Monitor JVMs

Step 6 -
Significant
garbage
collection
activity?

http://docs.appdynamics.com/download/attachments/20190325/jvm_sat.gif?version=1&modificationDate=1395796847000&api=v2
http://docs.appdynamics.com/display/PRO14S/Monitor+JVMs
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Is there significant garbage collection activity? 
How do I know?

How do I know if there is significant garbage collection
activity?

Display the Tier Flow Map.
Click the Nodes tab, and then click the Memory
tab.
Sort by GC Time Spent to see how many
milliseconds per minute is being spent on GC;
60,000 indicates 100%. .Show me how

If GC Time Spent is higher than 500 ms, the answer to
the question in Step 5 is Yes. Otherwise, the answer is
No.

Yes – Go to .Step 7

No – Go to .Step 8

Need more help?

Memory Usage and Garbage Collection

Step 7 -
Memory
leak?

http://docs.appdynamics.com/download/attachments/20190325/gc_time_spent.gif?version=1&modificationDate=1395796859000&api=v2
http://docs.appdynamics.com/display/PRO14S/Monitor+JVMs#MonitorJVMs-MemoryUsageandGarbageCollection
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1.  

2.  

3.  

Is there a memory leak?
How do I know?

How do I know if there is a memory leak?

From the list of nodes displayed in the previous step
(when you were checking for Garbage Collecting
activity), double-click a node that is experiencing
significant GC activity.
Click the Memory tab, then scroll down to display the
Memory Pool graphs at the bottom of the window.
Double-click the PS Old Gen memory pools. Show

.me how

If memory is not being released (use is trending
upward), the answer to this question is Yes. Otherwise,
the answer is No.

Yes – Use various AppDynamics features to track down
the leak. One useful tool for diagnosing a memory leak is
object instance tracking, which lets you track objects you
are creating and determine why they aren't being released
as needed. Using object instance tracking, you can
pinpoint exactly where in the code the leak is occurring.
For instructions on configuring object instance tracking, as
well as links to other tools for finding and fixing memory
leaks, see  below.Need more help?

No – Increase the size of the JVM. If there is significant GC
activity but there isn't a memory leak, then you probably
aren't configuring a large enough heap size for the
activities the code is performing. Increasing the available
memory should resolve your problem.

Whether you answered Yes or No, you have isolated the
problem and don't need to continue with the rest of the
steps below.

Need more help?

Troubleshoot Java Memory Leaks
Troubleshoot Java Memory Thrash
Configure and Use Object Instance Tracking for Java

http://docs.appdynamics.com/download/attachments/20190325/mem_leak.gif?version=1&modificationDate=1395796833000&api=v2
http://docs.appdynamics.com/download/attachments/20190325/mem_leak.gif?version=1&modificationDate=1395796833000&api=v2
http://docs.appdynamics.com/display/PRO14S/Configure+and+Use+Object+Instance+Tracking+for+Java
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Step 8 -
Resource
leak?
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1.  

2.  

3.  

Is there a resource leak?
How do I know?

How do I know if there is a resource leak?

In the left Navigation pane, go to (for example) Analyz
e -> Metric Browser -> Application Infrastructure
Performance <slow tier> -> Individual Nodes ->
<Problematic node> -> JMX -> JDBC Connection
Pools -> <Pool name>
Add the Active Connections and Maximum
Connections metrics to the graph.
Repeat as needed for various pools your application is
using.

If connections are not being released (use is trending
upward), the answer to the question in Step 7 is Yes.
Otherwise, the answer is No.

Yes – To determine where in your code resources are
being created but not being released as needed, take a
few thread dumps using standard commands on the
problematic node. You can also create a diagnostic action
within AppDynamics to create a thread dump; see Thread

.Dump Actions

No – Restart the JVM. If none of the above diagnostic
steps addressed your issue, it's possible you're simply
seeing a one-time unusual circumstance, which restarting
the JVM can resolve.

Need more help?

Diagnostic Actions

http://docs.appdynamics.com/display/PRO14S/Diagnostic+Actions#DiagnosticActions-ThreadDumpActions(Javaonly)
http://docs.appdynamics.com/display/PRO14S/Diagnostic+Actions#DiagnosticActions-ThreadDumpActions(Javaonly)
http://docs.appdynamics.com/display/PRO14S/Diagnostic+Actions
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1.  

None of the
above?

If slow response time persists even after you've completed the
steps outlined above, you may need to perform deeper
diagnostics.

If you can't find the information you need on how to do so in the
AppDynamics documentation, consider posting a note about
your problem in a community discussion topic. These
discussions are monitored by customers, partners, and
AppDynamics staff. Of course, you can also contact
AppDynamics support.

Need more help?

AppDynamics Pro Documentation
Community Discussion Boards (If you don't see
AppDynamics Pro as a topic, click Sign In at the upper
right corner of the screen.)

 

 

Configure Diagnostic Sessions For Asynchronous Activity

Automatic Diagnostic Sessions For Asynchronous Activity

Diagnostic sessions are triggered based on the performance metrics for a business transaction.
The average response time of a business transaction does not include the execution time of its
asynchronous activity. If you have asynchronous processing in your application, it might be
possible for the originating transaction to execute within normal bounds even though the
asynchronous activity takes longer than normal. To diagnose an issue like this, you can create a
custom health rule based on the average response time (or other performance metric) of the
asynchronous activity and use that health rule to set up a policy that triggers a diagnostic session
on the transaction. The general steps to do this are described in the following example that uses a
metric for an async thread task.

Create a custom health rule based on the asynchronous metric, such as average response
time. The metrics for thread tasks are visible in the metric browser under the Thread Tasks 
node for transactions with asynchronous activity. Each thread task has an individual node

http://docs.appdynamics.com/display/PRO14S/AppDynamics+Pro+Documentation
http://community.appdynamics.com/t5/Discussions/ct-p/Discussions
http://docs.appdynamics.com/display/PRO14S/Configure+Health+Rules#ConfigureHealthRules-custom-health-rule
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1.  

2.  

3.  

(usually its simple class name). Remember to select Custom as the type for the health rule.

 
Create a policy that is based on the baseline of the asynchronous metric of interest, for
example, the average response time.
Configure the policy to trigger a diagnostic session on the affected business transaction.

Troubleshoot Java Memory Issues

Troubleshoot Java Memory Leaks

Memory Leaks in a Java Environment
AppDynamics Java Automatic Leak Detection

Automatic Leak Detection Support
Conditions for Troubleshooting Java Memory Leaks

Workflow to Troubleshoot Memory Leaks
Monitor Memory for Potential JVM Leaks
Enable Memory Leak Detection
Troubleshoot Memory Leaks

Select the Collection Object to Monitor
Use Content Inspection
Use Access Tracking

Learn More

 

http://docs.appdynamics.com/display/PRO14S/Configure+Policies
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Memory Leaks in a Java Environment

While the JVM's garbage collection greatly reduces the opportunities for memory leaks to be
introduced into a codebase, it does not eliminate them completely. For example, consider a web
page whose code adds the current user object to a static set. In this case, the size of the set grows
over time and could eventually use up significant amounts of memory. In general, leaks occur
when an application code puts objects in a static collection and does not remove them even when
they are no longer needed.

In high workload production environments if the collection is frequently updated, it may cause the
applications to crash due to insufficient memory. It could also result in system performance
degradation as the operating system starts paging memory to disk.

AppDynamics Java Automatic Leak Detection

AppDynamics automatically tracks every Java collection (for example, HashMap and ArrayList)
that meets a set of criteria defined below. The collection size is tracked and a linear regression
model identifies whether the collection is potentially leaking. You can then identify the root cause
of the leak by tracking frequent accesses of the collection over a period of time.

Once a collection is qualified, its size, or number of elements, is monitored for long term growth
trend. A positive growth indicates that the collection as potentially leaking!

Once a leaking collection is identified, the agent automatically triggers diagnostics every 30
minutes to capture a shallow content dump and activity traces of the code path and business
transactions that are accessing the collection. By drilling down into any leaking collection
monitored by the agent, you can manually trigger Content Summary Capture and Access Tracking
sessions. See Configure Automatic Leak Detection for Java

You can also monitor memory leaks for custom memory structures. Typically custom memory
structures are used as caching solutions. In a distributed environment, caching can easily become
a prime source of memory leaks. It is therefore important to manage and track memory statistics
for these memory structures. To do this, you must first configure custom memory structures. See 

.Configure and Use Custom Memory Structures for Java

Automatic Leak Detection Support

Ensure AppDynamics supports Automatic Leak Detection on your JVM. See  .JVM Support

Conditions for Troubleshooting Java Memory Leaks

Automatic Leak Detection uses On Demand Capture Sessions to capture any actively used
collections (i.e. any class that implements JDK Map or Collection interface) during the Capture
period (default is 10 minutes) and then qualifies them based on the following criteria:

For a collection object to be identified and monitored, it must meet the following conditions:

The collection has been alive for at least   minutes. Default is 30 minutes, configurable withN
the   node property.minimum-age-for-evaluation-in-minutes
The collection has at least   elements. Default is 1000 elements, configurable with the N mini

 node property.mum-number-of-elements-in-collection-to-deep-size
The collection Deep Size is at least   MB. Default is 5 MB, configurable with the N minimum-si

 property.ze-for-evaluation-in-mb

http://docs.appdynamics.com/display/PRO14S/Configure+Automatic+Leak+Detection+for+Java
http://docs.appdynamics.com/display/PRO14S/Configure+and+Use+Custom+Memory+Structures+for+Java
http://docs.appdynamics.com/display/PRO14S/Supported+Environments+and+Versions
http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties+Reference#AppAgentNodePropertiesReference-minimum-age-for-evaluation-in-minutes
http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties+Reference#AppAgentNodePropertiesReference-minimumnumberofelementsincollectiontodeepsize
http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties+Reference#AppAgentNodePropertiesReference-minimumnumberofelementsincollectiontodeepsize
http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties+Reference#AppAgentNodePropertiesReference-minimum-size-for-evaluation-in-mb
http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties+Reference#AppAgentNodePropertiesReference-minimum-size-for-evaluation-in-mb
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The Deep Size is calculated by traversing recursive object graphs of all the objects in
the collection.

See   and  .App Agent Node Properties App Agent Node Properties Reference by Type

 

Workflow to Troubleshoot Memory Leaks

Use the following workflow to troubleshoot memory leaks on JVMs that have been identified with a
potential memory leak problem:

http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties
http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties+Reference+by+Type
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Monitor Memory for Potential JVM Leaks
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Use the Node Dashboard to identify the memory leak. A possible memory leak is indicated by a
growing trend in the heap as well as the old/tenured generation memory pool.

An object is automatically marked as a potentially leaking object when it shows a positive and
steep growth slope.

The Automatic Memory Leak dashboard shows:

Collection Size: The number of elements in a collection.

Potentially Leaking: Potentially leaking collections are marked as red. You should start
diagnostic sessions on potentially leaking objects.

Status: Indicates if a diagnostic session has been started on an object.

Collection Size Trend: A positive and steep growth slope indicates potential memory leak.

Tip: To identify long-lived collections compare the JVM start time and Object Creation Time.
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1.  

2.  

If you cannot see any captured collections, ensure that you have correct configuration for detecting
potential memory leaks.

Enable Memory Leak Detection

Before enabling memory leak detection, identify the potential JVMs that may have a leak. See Det
.ect Memory Leaks

Memory leak detection is available through the Automatic Leak Detection feature. Once the
Automatic Leak Detection feature is turned on and a capture session has been started,
AppDynamics tracks all frequently used collections; therefore, using this mode results in a higher
overhead. Turn on Automatic Leak Detection mode only when a memory leak problem is identified
and then start an On Demand Capture Session to start monitoring frequently used collections and
detect leaking collections.

Turn this mode off after you have identified and resolved the leak.

To achieve optimum performance, start diagnosis on an individual collection at a time.

Troubleshoot Memory Leaks

After detecting a potential memory leak, troubleshooting the leak involves performing the following
three actions:

Select the Collection Object that you want to monitor
Use Content Inspection
Use Access Tracking

Select the Collection Object to Monitor

On the Automatic Leak Detection dashboard, select the name of the class that you want to
monitor.
Click   on the top left-hand side of the memory leak dashboard.Drill Down
Alternatively right-click the class name and click  .Drill Down

  To  achieve optimum performance, start the troubleshooting session on aIMPORTANT:
single collection object at a time.

http://docs.appdynamics.com/display/PRO14S/Monitor+JVMs
http://docs.appdynamics.com/display/PRO14S/Monitor+JVMs
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1.  
2.  
3.  
4.  
5.  

Use Content Inspection

Use Content Inspection to identify which part of the application the collection belongs to so that
you can start troubleshooting. It allows monitoring histograms of all the elements in a particular
collection.

As described above in  , enable Automatic LeakWorkflow to Troubleshoot Memory Leaks
Detection, start an On Demand Capture Session, select the object you want to troubleshoot, and
then follow the steps listed below:

Click the Content Inspection tab.
Click   to start the content inspection session.Start Content Summary Capture Session
Enter the session duration. Allow at least 1-2 minutes for data generation.
Click   to retrieve the session data.Refresh
Click on the snapshot to view details about an individual session.

Exporting Troubleshooting Information
You can also export the troubleshooting information into Excel files using the Export button
under Content Summary.
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1.  
2.  
3.  
4.  
5.  

Use Access Tracking

Use Access Tracking to view the actual code paths and business transactions accessing the
collections object.

As described above in  , enable Automatic LeakWorkflow to Troubleshoot Memory Leaks
Detection, start an On Demand Capture Session, select the object you want to troubleshoot, and
then follow the steps listed below:

Select the Access Tracking tab
Click   to start the tracking session.Start Access Tracking Session
Enter the session duration. Allow at least 1-2 minutes for data generation.
Click   to retrieve session data.Refresh
Click on the snapshot to view details about an individual session.

Exporting Troubleshooting Information
You can also export the troubleshooting information into Excel files using the Export button
under Content Summary.
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Learn More

App Agent Node Properties
Monitor JVMs
Metric Browser

Troubleshoot Java Memory Thrash

Memory Thrash and Object Instance Tracking
Prerequisites for Object Instance Tracking

Specifying the Classpath
Workflow for Detecting and Troubleshooting Memory Thrash
Analyzing Memory Thrash

To analyze memory thrash problems
To verify memory thrash

Troubleshooting Java Memory Thrash Using Allocation Tracking
To use allocation tracking

Memory Thrash and Object Instance Tracking

Memory thrash is caused when a large number of temporary objects are created in very short
intervals. Although these objects are temporary and are eventually cleaned up, the
garbage collection mechanism may struggle to keep up with the rate of object creation. This may
cause application performance problems. Monitoring the time spent in garbage collection can
provide insight into performance issues, including memory thrash. For example, an increase in the

http://docs.appdynamics.com/display/PRO14S/App+Agent+Node+Properties
http://docs.appdynamics.com/display/PRO14S/Monitor+JVMs
http://docs.appdynamics.com/display/PRO14S/Metric+Browser
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number of spikes for major collections either slows down a JVM or indicates potential memory
thrash   To configureUse object instance tracking to isolate the root cause of the memory thrash.
and enable object instance tracking, see  .Configure and Use Object Instance Tracking for Java

AppDynamics automatically tracks the following classes:

Application Classes
System Classes

The Object Instance Tracking feature maps a histogram of every object in the JVM. The Object
Instance Tracking dashboard not only provides the number of instances for a particular class but
also provides the shallow memory size (the memory footprint of the object and the primitives it
contains) used by all the instances.

 

Prerequisites for Object Instance Tracking

Object Instance Tracking can be used only for Sun JVM v1.6.x and later. 
If you are running with the JDK then tools.jar will probably be setup correctly, but if you are
running with the JRE you must add tools.jar to JRE_HOME/lib/ext and restart the JVM for
this feature to start working. You can find the tools.jar file in JAVA_HOME/lib/tools.jar.
In some cases In some cases you might also need to copy libattach.so (Linux) or attach.dll
(Windows) from your JDK to your JRE. 
Depending on the JDK version, you may also need to specify the classpath as shown below
(along with other -jar options).

Specifying the Classpath

When using a JDK tool, set the classpath using the -classpath option. This sets the classpath for
the application only. For example:

On Windows

http://docs.appdynamics.com/display/PRO14S/Configure+and+Use+Object+Instance+Tracking+for+Java
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java -classpath <complete-path-to-tools.jar>;%CLASSPATH% -jar myApp.jar

OR

On Unix

java -classpath <complete-path-to-tools.jar>:$CLASSPATH -jar myApp.jar

Alternatively, you can set the CLASSPATH variable for your entire environment. For example:

 On Windows

SET CLASSPATH=%CLASSPATH%;%JAVA_HOME%\lib\tools.jar

On Unix

CLASSPATH=$CLASSPATH:$JAVA_HOME/lib/tools.jar

 

 

Workflow for Detecting and Troubleshooting Memory Thrash

The following diagram outlines the workflow for monitoring and troubleshooting memory thrash
problems in a production environment.

To monitor memory leaks, on the node dashboard, use the Memory -> Automatic Leak
Detection subtab. See .Troubleshoot Java Memory Leaks
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1.  

Analyzing Memory Thrash

To analyze memory thrash problems

Once a memory thrash problem is identified in a particular collection, start the diagnostic session
by drilling down into the suspected problematic class.

Select the class name to monitor and click   at the top of the Object InstanceDrill Down
Tracking dashboard.

Or right click the class name and select the Drill Down option.

After the drill down action is triggered, data collection for object instances is performed every
minute. This data collection is considered to be a diagnostic session and the Object Instance
Tracking dashboard for that class is updated with this icon   , to indicate that a diagnostic
session is in progress.

 For optimal performance, trigger a drill down action on a single instance or class name at
a time.
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1.  

2.  

The Object Instance Tracking dashboard indicates possible cases of memory thrash.

The following provides more detail on the meaning of each of the columns on the Object Instance
Tracking dashboard.

Prime indicators of memory thrash problems are:

Current Instance Count: A high number indicates possible allocation of large number of
temporary objects.

Shallow Size: A large number for shallow size signals potential memory thrash.

Instance Count Trend: A saw wave is an instant indication of memory thrash.

If you suspect you have a memory thrash problem at this point, then you should verify that this is
the case.  See  .To verify memory thrash

To verify memory thrash

Select the class name to monitor and click   at the top of the Object InstanceDrill Down
Tracking dashboard.
On the Object Instance Tracking window, click  .Show Major Garbage Collections

The following Object Instance Tracking Overview provides further evidence of a memory thrash
problem.
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1.  
2.  
3.  

4.  
5.  
6.  
7.  

If the instance count doesn’t vary with the garbage collection cycle, it is an indication of potential
leak and not a memory thrash problem. See  .Troubleshoot Java Memory Leaks

Troubleshooting Java Memory Thrash Using Allocation Tracking

Allocation Tracking tracks all the code paths and those business transactions that are allocating
instances of a particular class.

Allocation tracking detects those code path/business transactions that are creating and throwing
away instances.

To use allocation tracking

Using the Drill Down option, trigger a diagnostic session.
Click the Allocation Tracking tab.
Click   to start tracking code paths and businessStart Allocation Tracking Session
transactions.
Enter the session duration and allow at least 1-2 minutes for data generation.
Click   to retrieve the session data.Refresh
Click on a session to view its details. 
Use the Information presented in the Code Paths and Business Transaction panels to
identify the origin of the memory thrash problem.
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Detect Code Deadlocks for Java
Code Deadlocks and their Causes

Finding Deadlocks using the Events
List

To Examine a Code Deadlock
Finding Deadlocks Using the REST
API

Learn More

By default the agent detects code deadlocks. You can find deadlocks and see their details using
the Events list or the REST API.

Code Deadlocks and their Causes

In a multi-threading development environment, it is common to use more than a single lock.
However sometimes deadlocks will occur. Here are some possible causes:

The order of the locks is not optimal
The context in which they are being called (for example, from within a callback) is not correct
Two threads may wait for each other to signal an event

Finding Deadlocks using the Events List

Select  (or just ) in the Filter By Event Type list to see codeCode Problems Code Deadlock
deadlocks in the Events list. See . The following list shows twoFilter and Analyze Events

Read a real-life story about how
AppDynamics helped identify code
deadlocks and reduce the risk to
revenue!

http://docs.appdynamics.com/display/PRO14S/Filter+and+Analyze+Events
http://www.appdynamics.com/blog/2012/03/21/how-code-deadlock-can-kill-your-business/
http://www.appdynamics.com/blog/2012/03/21/how-code-deadlock-can-kill-your-business/
http://www.appdynamics.com/blog/2012/03/21/how-code-deadlock-can-kill-your-business/
http://www.appdynamics.com/blog/2012/03/21/how-code-deadlock-can-kill-your-business/
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deadlocks in the ECommerce tier.

To Examine a Code Deadlock

1. Double-click the deadlock event in the events list.
The Code Deadlock  tab displays.Summary

2. To see details about the deadlock click the  tab and scroll down.Details

Finding Deadlocks Using the REST API
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You can detect a DEADLOCK event-type using the AppDynamics REST API. For details see the
example .Retrieve event data

Learn More

Use the AppDynamics REST API

Troubleshooting Tutorials for Java
Tutorial for Java - Business Transaction Health Drilldown

Business Transaction Drilldown 

Download MP4 version: BTHealthDrilldown.mp4
Download QuickTime version: BTHealthDrilldown.mov

Tutorial for Java - Exceptions
The Exceptions
Drill Down into the HTTP Error Code Exception
Drill Down into the AxisFault Exception
Drill Down into the Logger Exception
See How Exceptions are Configured
Learn More

The Exceptions

An exception is a code-logged message outside the context of a business transaction. Common
exceptions include code exceptions or logged errors, HTTP error codes, and error page redirects.

Exceptions display in the Exceptions pane of many dashboards.

Click Exceptions to quickly see a list, ordered by frequency.

http://docs.appdynamics.com/display/PRO14S/Use+the+AppDynamics+REST+API#UsetheAppDynamicsRESTAPI-Retrieveeventdata
http://docs.appdynamics.com/display/PRO14S/Use+the+AppDynamics+REST+API
http://docs.appdynamics.com/download/attachments/20187332/BTHealthDrilldown.mp4?version=1&modificationDate=1394226197000&api=v2
http://docs.appdynamics.com/download/attachments/20187332/BTHealthDrilldown.mov?version=1&modificationDate=1394226197000&api=v2
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Drill Down into the HTTP Error Code Exception

Notice the spike in the HTTP Error Codes graph, and that the "Page Not Found: 404 error" is the
most frequent.

To find out more about the 404 error, click the row.

The list of URLs shows pages that have 404 errors. The memberLogOut and getAllItems URLs
have the most 404 errors. You can provide this information to the web team to determine why
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those pages have so many 404 errors.

Drill Down into the AxisFault Exception

In the Exceptions tab, click the AxisFault row. A list of error snapshots shows the affected URL,
tier, and node.

Click a row and then click the Stack Traces for This Exception tab to drill down further. Then click
on one of the exceptions to see the stack trace.
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Share the stack trace with the development team to solve the problem.

Drill Down into the Logger Exception

In the Exceptions tab, click the Log4J Error Messages row. A list of error transaction snapshots
shows the affected URL, business transaction, tier, and node. You can see a graph of the
errors-per-minute data.

Click on a row to see the flow map for the error transaction snapshot.
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The icons for both tiers have a Drill Down button. Click the Drill Down button on Ecommerce tier; it
also says "Start", indicating that the transaction started on this tier.

The Call Drill Down shows the summary of the error message.
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You can use the Export to PDF button at the lower left to send this information to your colleagues.

Go back to the flow map and click the Inventory tier  button. You see the Call DrillDrill Down
Down of the Inventory tier error message.

Compare the two error messages.

See How Exceptions are Configured

AppDynamics provides application-level default configurations for detecting exceptions. In the left
navigation pane click .Configure -> Instrumentation -> Error Detection



Copyright © AppDynamics 2012-2014 Page 83

Learn More

Troubleshoot Errors
Configure Error Detection

Tutorial for Java - Slow Transactions

To begin troubleshooting,  click :Troubleshoot -> Slow Response Times

http://docs.appdynamics.com/display/PRO14S/Configure+Error+Detection
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To troubleshoot slow business transaction URLs, select the Slow Transactions tab and use the
Transaction Snapshots pane:

Once you select the URL you will see a visualization of the transaction. You can drill into a call
graph by clicking the drill-down icon.
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Once you are in the call graph you can look for methods that have a significant response time. For
example, the executeQuery method is responsible for 99% of response time:

From the   page, you can also select the Slowest DB &Troubleshoot -> Slow Response Times
Remote Service Calls tab:
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You can drill into the transaction snapshots from this tab to see the snapshot view:

For more information on resolving issues related to slow transactions, see Troubleshoot Slow
.Response Times for Java

Tutorial for Java - Troubleshooting using Events

Troubleshooting with Events
How to Set up the Events List
How to Know Something is Not Quite Right
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How to Investigate
Investigating Errors
Investigating Stalled Business Transactions
Investigating Slow Business Transactions
Investigating Application Server Exceptions
Investigating Code Deadlocks
Investigating Application Change Events

Troubleshooting with Events

How to Set up the Events List

1. From the left navigation pane, click an application and then click .Events

2. In the  window, use the filter criteria to pick which events you want to monitor. Click Events Sear
.ch

3. Set the time range.

4. Look for issues and anomalies.

How to Know Something is Not Quite Right

You see:

Red (critical, policy violation)
Purple (warning, stall)
Orange (warning, very slow)
Yellow (warning, slow)

How to Investigate

You drill down to the root cause of the problem in different ways depending on the type of event.

Investigating Errors

You can troubleshoot application issues by drilling down into errors.

1. In the  window click an .Events Error

2. In the  click the Drill Down icon. If there are multiple drill down icons,Transaction Flow Map
select the one with the transaction that takes the most time.

You can also access the  window by clicking  on the right side of theEvents Events
application dashboard.
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3. In the  window click the  tab.Call Drill Down Summary

4. Use the  information to troubleshoot issues. This information can also be exported toSummary
PDF.

Investigating Stalled Business Transactions

You can troubleshoot business transactions by drilling down into stalled business transactions.

1. In the  window click a  row.Events Slow Requests - Stalled
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2. In the  click the Drill Down icon.Transaction Flow Map

3. In the  window click the  tab.Call Drill Down Summary

4. Use the   information to troubleshoot business transaction issues. This information canSummary
also be exported to PDF.

Investigating Slow Business Transactions

You can troubleshoot business transactions by drilling down into slow or very slow business
transactions.

1. In the  window click a  or  row.Events Slow Requests - Very Slow Slow
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2. In the  click the  icon. If there are multiple drill down icons,Transaction Flow Map Drill Down
select the one with the transaction that takes the most time.

If there is more than one call from the originating Tier, you will see the  window. InSelect a Call
this case, proceed to step 3. Otherwise, skip to step 4. 

3. In the  window click the slowest call.Select a Call

4. In the  window click the  tab to see the slowest methods.Call Drill Down Hot Spots
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5. In this example, since the slow call is a database call you know you can click the  tabSQL Calls
to see the slowest SQL statement.

6. Use this information to diagnose transaction issues. This information can also be exported to
PDF.

Investigating Application Server Exceptions

You can troubleshoot application server issues by drilling down into application server exceptions.

1. In the  window click an .Events Application Server Exception

2. In the  window, click the  tab.Application Server Exception Details
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3. Use this information to troubleshoot application server issues. Use the  buttoCopy to Clipboard
n to save the exception details.

Investigating Code Deadlocks

You can troubleshoot code deadlocks by drilling down into a code deadlocks.

1. In the  window click a .Events Code Deadlock

2. In the  window click the  tab.Code Deadlock Details
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3. Use this information to troubleshoot code deadlock issues. Use the   buttonCopy to Clipboard
to save the deadlock details.

Investigating Application Change Events

You can view application changes by drilling down into application change events.

1. Click a change event to see a summary and details, for example:

2. Use this information to view application changes. Use the   button to save theCopy to Clipboard
change details.

Troubleshoot .NET Application Problems

Troubleshoot Slow Response Times for .NET

How Do You Know Response Time is Slow?
You Received an Alert
You are Viewing the Application Dashboard for a Business Application

Initial Troubleshooting Steps
Troubleshooting Methodology

Step 1 - All nodes?
Step 2 - Most business transactions?
Step 3 - Backend problem?
Step 4 - CPU saturated?
Step 5 - Significant garbage collection activity?
Step 6 - Memory leak?
None of the above?

How Do You Know Response Time is Slow?

There are two primary ways you can learn that your application's response time is slow: receiving

By default AppDynamics reports events when applications are deployed, app servers are
restarted, and configuration parameters are changed. Since these are not problems, they
are indicated by a blue icon.
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1.  

an alert and looking at an Application Dashboard.

You Received an Alert

If you have received an email alert from AppDynamics that was configured through the use of Heal
, ,  or , the email message provides a number of detailsth Rules Policies Actions Workflow Overview

about the problem that triggered the alert. See .Email Notifications

If the problem is related to slow response time, see .Initial Troubleshooting Steps

You are Viewing the Application Dashboard for a Business Application

NOTE: If you know the slow response time relates to a particular business transaction, e.g. an
internal tester reported "Searching for a hotel is slow," skip to the answer No in .Step 2

Display the Application Dashboard (flow map). Look for lines that are yellow or red or tiers
that are not entirely green.

http://docs.appdynamics.com/display/PRO14S/Health+Rules
http://docs.appdynamics.com/display/PRO14S/Health+Rules
http://docs.appdynamics.com/display/PRO14S/Policies
http://docs.appdynamics.com/display/PRO14S/Actions
http://docs.appdynamics.com/display/PRO14S/Workflow+Overview
http://docs.appdynamics.com/display/PRO14S/Notification+Actions#NotificationActions-EmailNotifications
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If multiple tiers are red or yellow, the problem might be related to a backend (database or
other remote service). Skip to .Step 3
Otherwise, begin troubleshooting with .Initial Troubleshooting Steps

Need more help?

Application Dashboard
Flow Maps

Initial Troubleshooting Steps

In some cases, the source of your problem might be easily diagnosed by choosing Troubleshoot
 in the Navigation Pane. See .-> Slow Response Times Troubleshoot Slow Response Times

If you've tried to diagnose the problem using those techniques and haven't found the problem, use
the following troubleshooting methodology to find other ways to determine the root cause of your
issue.

Troubleshooting Methodology

 

Step 1 - All
nodes?

Is the problem affecting all nodes in a slow tier?

http://docs.appdynamics.com/display/PRO14S/Application+Dashboard
http://docs.appdynamics.com/display/PRO14S/Flow+Maps
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How do I know?

How do I know if the problem is affecting all nodes?

In the Application or Tier Flow Map, click the number
that represents how many nodes are in the tier. This
provides a quick overview of the health of each node
in the tier. The small circle icon indicates whether the
server is up with the agent reporting, and the larger
circle icon indicates Health Rule violation status.

If all the nodes are yellow or red, the answer to the question
in Step 1 is Yes. Otherwise, the answer is No.

Yes – Go to .Step 2

No – The problem is either in the node's hardware or in the way
the software is configured on the node. If only one node in a tier
is affected, the problem is probably not related to the
application code.

In the left navigation pane, click Servers -> App Servers
 to display the-> <slow tier> -> <problematic node>

Node Dashboard flow map.
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Click the Dashboard tab to get a view of the overall
health of the node.
Click the Hardware tab to see if there is a hardware
resource issue.
Click the Memory tab and sort on various column
headings to determine if there is a shortage of memory or
other memory issue.

You have isolated the problem and don't need to continue with
the rest of the steps below.

Need more help?

Node Dashboard

Step 2 -
Most
business
transaction
s?

Is the problem affecting most of the business transactions?

http://docs.appdynamics.com/display/PRO14S/Node+Dashboard
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1.  

1.  
2.  

3.  

How do I know?

How do I know if the problem is affecting most of the
business transactions?

On the Application Dashboard, look at the Business
Transaction Health pane on the right side of the
screen.

If the bar representing business transaction health is
primarily yellow or red, the answer to the question in Step 2
is Yes. Otherwise, the answer is No.

Yes – Go to .Step 3

No –

In the left navigation pane, click  .Business Transactions
Sort by Health, Server Time, or other column headings to
find the business transaction that is experiencing issues.
Double-click the problematic business transaction to see
its Dashboard, then use the tabs to diagnose the
problem.

You have isolated the problem and don't need to continue with
the rest of the steps below.

Need more help?
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Business Transaction Dashboard
Business Transaction Monitoring
Business Transactions List
Transaction Snapshots

Step 3 -
Backend
problem?

Are the nodes linked to a backend (database or other remote
service) that might be causing your problem?

How do I know?

How do I know if the nodes are linked to a backend
(database or other remote service) that might be causing
my problem?

Display the Tier Flow Map. If any nodes are linked to a
backend, links to those backends are displayed in the
flow map.

If a backend or the line connecting to a backend is red, the
answer to the question in Step 3 is Yes. Otherwise, the
answer is No.

Yes –

Click the line connecting to the backend to see an
information window about the backend. The contents of
the information window vary depending on the type of
backend. Use the various tabs to find the source of the
issue.

http://docs.appdynamics.com/display/PRO14S/Business+Transaction+Dashboard
http://docs.appdynamics.com/display/PRO14S/Business+Transaction+Monitoring
http://docs.appdynamics.com/display/PRO14S/Business+Transactions+List
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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If the backend is a database, right-click the database
icon. You have a number of options that let you see the
dashboard, drill down, etc. If you have AppDynamics for
Databases, choose Link to AppDynamics for Databases.
You can use AppDynamics for Databases to diagnose
database issues.

You have isolated the problem and don't need to continue with
the rest of the steps below.

No – Go to .Step 4

Need more help?

Backend Monitoring
Configure Backend Detection for .NET
AppDynamics for Databases

http://docs.appdynamics.com/display/PRO14S/Backend+Monitoring
http://docs.appdynamics.com/display/PRO14S/Configure+Backend+Detection+for+.NET
http://docs.appdynamics.com/display/ADDB/AppDynamics+for+Databases
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1.  
2.  
3.  

Step 4 -
CPU
saturated?

Is the CPU of the CLR saturated?
How do I know?

How do I know if the CPU of the CLR is saturated?

Display the Tier Flow Map.
Click the Nodes tab, and then click the Hardware tab.
Sort by CPU % (current).

If the CPU % is 90 or higher, the answer to the question in
Step 4 is Yes. Otherwise, the answer is No.

Yes – Go to .Step 5

No – Review various metrics in the Metric Browser to pinpoint
the problem.

In the left navigation pane, click Servers -> App Servers ->
. Review these metrics in particular:<slow tier>

ASP.NET -> Application Restarts
ASP.NET -> Request Wait Time
ASP.NET -> Requests Queued

CLR -> Locks and Threads -> Current Logical Threads
CLR -> Locks and Threads -> Current Physical Threads

IIS -> Number of working processes
IIS -> Application pools -> <Business application name>
-> CPU%
IIS -> Application pools -> <Business application name>
-> Number of working processes
IIS -> Application pools -> <Business application name>
-> Working Set
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1.  
2.  
3.  

You have isolated the problem and don't need to continue with
the rest of the steps below.

Need more help?

Monitor .NET Applications

Step 5 -
Significant
garbage
collection
activity?

Is there significant garbage collection activity?
How do I know?

How do I know if there is significant garbage collection
activity?

Display the Tier Flow Map.
Click the Nodes tab, and then click the Memory tab.
Sort by Time Spent on Collections (%) to see what
percentage of processing time is being taken up with
garbage collection activity.

If Time Spent on Collections (%) is higher than acceptable
(say, over 40%), the answer to the question in Step 5 is Yes.
Otherwise, the answer is No.

Yes – Go to .Step 6

No – Use your standard tools to produce memory dumps;
review these to locate the source of the problem.

You have isolated the problem and don't need to continue with
the rest of the steps below.

Need more help?

Monitor .NET Applications

Step 6 -
Memory
leak?

http://docs.appdynamics.com/display/PRO14S/Monitor+.NET+Applications
http://docs.appdynamics.com/display/PRO14S/Monitor+.NET+Applications
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1.  

2.  

Is there a memory leak?
How do I know?

How do I know if there is a memory leak?

From the list of nodes displayed in the previous step
(when you were checking for garbage collecting
activity), double-click a node that is experiencing
significant GC activity.
Click the Memory tab, then review the committed
bytes counter and the size of the Gen0, Gen1, Gen2
and large heaps.

If memory is not being released (one or more of the above
indicators is trending upward), the answer to the question in
Step 6 is Yes. Otherwise, the answer is No.

Yes – Use your standard tools for troubleshooting memory
problems. You can also review ASP.NET metrics; click Servers

.-> App Servers -> <slow tier> -> ASP.NET

No – Use your standard tools to produce memory dumps;
review these to locate the source of the problem.

Whether you answered Yes or No, you have isolated the
problem and don't need to continue with the rest of the steps
below.

Need more help?

Monitor .NET Applications

http://docs.appdynamics.com/display/PRO14S/Monitor+.NET+Applications
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None of the
above?

If slow response time persists even after you've completed the
steps outlined above, you may need to perform deeper
diagnostics.

If you can't find the information you need on how to do so in the
AppDynamics documentation, consider posting a note about
your problem in a community discussion topic. These
discussions are monitored by customers, partners, and
AppDynamics staff. Of course, you can also contact
AppDynamics support.

Need more help?

AppDynamics Pro Documentation
Community Discussion Boards (If you don't see
AppDynamics Pro as a topic, click Sign In at the upper
right corner of the screen.)

Troubleshoot PHP Application Problems
The  show you when problems occur and you needDashboards
to take action. For example the  monitorsTransaction Scorecard
business transactions and categorizes their performance
according to .thresholds

http://docs.appdynamics.com/display/PRO14S/AppDynamics+Pro+Documentation
http://community.appdynamics.com/t5/Discussions/ct-p/Discussions
http://docs.appdynamics.com/display/PRO14S/Dashboards
http://docs.appdynamics.com/display/PRO14S/Scorecards
http://docs.appdynamics.com/display/PRO14S/Thresholds
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Troubleshooting Your

Application

For common
troubleshooting
scenarios see:

Troubleshoot
Slow Response
Times for PHP
Troubleshoot
Errors for PHP
Troubleshoot
Health Rule
Violations

When AppDynamics indicates a problem you can easily go right into troubleshooting mode.

From the All Applications dashboard click the Troubleshoot link.

Alternatively, after you have selected the application, from the left navigation menu click Tro
 .ubleshoot

For more information about troubleshooting see:

Troubleshoot Slow Response Times for PHP
Troubleshoot Errors for PHP
Troubleshoot Health Rule Violations
Troubleshoot Node Problems
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Transaction Snapshots
Call Graphs
Diagnostic Sessions
Analyze

Troubleshoot Slow Response Times for PHP
Slow and Stalled Transactions

To troubleshoot slow and stalled transactions
Slow Database and Remote Service Calls

To troubleshoot slow database and remote service
calls

Learn More

When you click  theTroubleshoot -> Slow Response Times
Slow Response Times window opens showing two tabs. You
can drill down into transaction issues in the Slow Transactions

 and into database or remote services issues in the tab Slowest
.DB & Remote Services tab

This two minute interactive video
traces the typical steps of
identifying the cause of a slow
transaction.

Slow and Stalled Transactions

There are many reasons why a business transaction may be slow or stalled. The Slow Response
Times tab helps you find the root cause whether that be resource contention, deadlock, race
condition, or something else.

By default AppDynamics considers a slow transaction one that lasts longer than 3 times the
standard deviation for the last two hours and a very slow transaction 4 times the baseline for the
last two hours.

By default AppDynamics considers a transaction that lasts longer than 45 seconds (4500
milliseconds) to be stalled.

You can configure these thresholds to better match your environment. See  and Thresholds Config
.ure Thresholds

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
https://appdynamics-static.com/education/video/troubleshootingErrors/story.html
http://docs.appdynamics.com/display/PRO14S/Thresholds
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
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To troubleshoot slow and stalled transactions

1. Click .Troubleshoot -> Slow Response Times
You can also access this information from tabs in the various dashboards.

2. Click the  tab if it is not selected.Slow Transactions
In the upper pane AppDynamics displays a graph of the slow, very slow, and stalled transactions
for the time period specified in the Time Range drop-down menu. Click the Plot Load checkbox to
see the load.

In the lower pane AppDynamics displays the transaction snapshots for slow, very slow, and stalled
transactions.

Click the Exe Time column to sort the transactions from slowest to fastest.

To drill down, select a snapshot from the list and click . A transactionView Transaction Snapshot
snapshot shows the details of an instance of a business transaction, including a call graph that
helps you identify the root cause of the slow response time. See .Transaction Snapshots

Slow Database and Remote Service Calls

Although AppDynamics does not instrument database and remote service servers directly, it
collects metrics about calls to these backends from the instrumented app servers. This allows you
to drill down to the root cause of slow database and remote service calls.

To troubleshoot slow database and remote service calls

1. Click .Troubleshoot -> Slow Response Times
You can also access this information from tabs in the various dashboards.

2. Click the  tab if it is not selected.Slowest DB & Remote Service Calls

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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3. In the Call Type panel select the type of call for which you want to see information or select All
Calls.
The Call panel displays the call or query with the average time per call, number of calls, and
maximum execution time (Max Time) for the calls with the longest execution time.

If transaction snapshots are available for a slow call, you can click  link or youView Snapshots
can select the call and click the  tab in the lower panel. From there you canCorrelated Snapshots
select a snapshot and click  to drill down to the root cause of theView Transaction Snapshot
slow call.

See .Transaction Snapshots

Learn More

Transaction Snapshots
Configure Thresholds

Troubleshoot Errors for PHP
Error Transactions and Exceptions

To Troubleshoot Error Transactions
To Troubleshoot Exceptions

Learn More
Identifying and troubleshooting errors in your
application.
 

Error Transactions and Exceptions

An error transaction is a business transaction that experienced an error during the transaction
execution. The error can be:

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
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A runtime error reported by the PHP server and captured by the agent. These include Fatal
Errors, Warning and Notices thrown by the PHP runtime. These types of errors do not
provide a stack trace.

Certain exceptions thrown by the application. These include unhandled exceptions (when an
exception is thrown and there is no  block) and handled exceptions during an exit calltry
(when there is a  block during an exit call). These types of errors do provide a stack trace.try

If a transaction experiences an error, it is counted as an error transaction and not as a slow, very
slow or stalled transaction even if the transaction was also slow or stalled.

There is not a one-to-one correspondence between the number of errors and the number of
exceptions. For example, a business transaction may experience a single code 500 error in which
several exceptions were logged as the transaction passed through multiple tiers.

You can configure the types of errors that AppDynamics detects as well as the types of exceptions
to ignore. See .Configure Error Detection for PHP
 
 

To Troubleshoot Error Transactions

1. Click  in the left navigation panel.Troubleshoot -> Errors

The error viewer opens.

2. Click the   tab if it is not already selected.Error Transactions

3. From the time range drop-down menu select the time range for which you want to view
information about error transactions.

A graph of the error transactions displays at the top of the viewer. You can get an exact count of
the errors per minute at a particular point in time by hovering with your pointing device on the line
in the graph.

To the right of the graph is a summary of the load and the error transactions.

Check the Plot check box if you want the graph at the top of the viewer to show the load over the
selected time period. Clear this check box if you want the graph to show only the error
transactions.

http://docs.appdynamics.com/display/PRO14S/Configure+Error+Detection+for+PHP
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4. The error transaction snapshots are listed in the lower part of the viewer. To filter this list click S
 and select the filter criteria.how Filters

5. To examine the root cause of an error, select the snapshot from the list and click View
. See  for information about examining snapshots.Transaction Snapshot Transaction Snapshots

6. To identify the most expensive calls or queries, select a snapshot from the list and click Analyze
and then click .Identify the most expensive calls / SQL statements in a group of snapshots

The Most Expensive Methods / SQL Statements viewer opens.

7. In the lower panel click the  tab to view the methods with their total andExpensive Methods
average execution times and call counts. Click the   tab to view the queries withExpensive SQL
their counts and execution times.

To Troubleshoot Exceptions

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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1. Click  in the left navigation panel.Troubleshoot -> Errors

2. Click the  tab if it is not already selected.Exceptions

The total exception count, HTTP Error Codes and Error Page Redirects for the selected time
range are reported in the upper panel. You can get an exact count of the exceptions per minute at
a particular point in time by hovering with your pointing device on the line in the graphs.

The exceptions list is displayed in the lower panel.

To filter the exception list, enter the filter term in the filter text field.
To see only exceptions with performance data, clear the Show Exceptions with 0 count
checkbox.

3. To view details of a particular exception, select the exception the list in the lower panel and click
.View Details

4. To view transaction snapshots for an exception:

a. In the exception detail window, click the  subtab.Occurrences of this Exception

b. Select a snapshot from the list.

c. Click .View Details

d. In the snapshot flow map that displays, click  to get the details of the snapshot. See Drill Down
.Transaction Snapshots

5. To view a stack trace for an exception:

a. In the exception detail window, click the  tab.Stack Traces for this Exception

b. Click an exception in the left panel.

The right panel displays the stack trace for the selected exception.

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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Learn More

Configure Error Detection for PHP
Transaction Snapshots

Troubleshoot Node.Js Application Problems

Troubleshoot Slow Response Times for Node.js

Slow and Stalled Transactions
To troubleshoot slow and stalled transactions

High CPU Times
To troubleshoot slow processes

Learn More

When you click the Slow Response Times windowTroubleshoot -> Slow Response Times, 
opens showing two tabs. You can drill down into transaction issues in the  aSlow Transactions tab
nd into database or remote services issues in the .Slowest DB & Remote Services tab

Slow and Stalled Transactions

There are many reasons why a business transaction may be slow or stalled.

By default AppDynamics considers a slow transaction one that lasts longer than 3 times the
standard deviation for the last two hours and a very slow transaction 4 times the baseline for the
last two hours.

By default AppDynamics considers a transaction that lasts longer than 45 seconds (4500
milliseconds) to be stalled.

You can configure these thresholds to better match your environment. See  and Thresholds Config
.ure Thresholds

To troubleshoot slow and stalled transactions

Click .Troubleshoot -> Slow Response Times
Click the  tab if it is not selected.Slow Transactions
In the upper pane AppDynamics displays a graph of the slow, very slow, and stalled
transactions for the time period specified in the Time Range drop-down menu. Click the Plot
Load check box to see the load.

In the lower pane AppDynamics displays the transaction snapshots for slow, very slow, and

http://docs.appdynamics.com/display/PRO14S/Configure+Error+Detection+for+PHP
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Troubleshoot+Slow+Response+Times+for+PHP#TroubleshootSlowResponseTimesforPHP-SlowandStalledTransactions
http://docs.appdynamics.com/display/PRO14S/Troubleshoot+Slow+Response+Times+for+PHP#TroubleshootSlowResponseTimesforPHP-SlowDatabaseandRemoteServiceCalls
http://docs.appdynamics.com/display/PRO14S/Thresholds
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
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stalled transactions.

Click the Exe Time column to sort the transactions from slowest to fastest.
To drill down, select a snapshot from the list and click . AView Transaction Snapshot
transaction snapshot shows the details of an instance of a business transaction. See Transa

 for information about drilling down into a snapshot. ction Snapshots

High CPU Times

Your user experience may be slow because of processes that consume a lot of CPU time blocking
other processes.

To troubleshoot slow processes

In the node dashboard click the Process Snapshots tab.
Click Collect Process Snapshots.
In the Collect a Process Snapshot window set the duration to between 1 and 60 seconds.
Click Start.

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
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In a few minutes you should see some process snapshots in the list.
Sort the list by toggling the Exe Time column in the process snapshots list so that the
snapshots for the slowest processes are at the top of the list.
Double-click one of the slow process snapshots.
In the process snapshot, click the CALL GRAPH tab if it is not selected.
Examine the Time column in the call graph to identify which of the calls are slow.

Click the  at the end of the row for the slow call to see details.

Learn More

Monitor Node.js Business Transactions
Monitor Node.js Processes
Transaction Snapshots
Configure Thresholds

Troubleshoot Mobile Applications

Troubleshoot Slow Network Requests from Mobile Applications

Identifying the Slowest Network Requests
To identify slow network requests

Finding Causes of Slow Network Requests
To investigate details of the slowest individual requests

Learn More

Identifying the Slowest Network Requests

First identify which network requests are the slowest.

To identify slow network requests

In the left navigation pane click either   for iOS applications or End User Experience->iOS E
 for Android applications.nd User Experience->Android

The Mobile APM dashboard opens. 
Click the Network Requests tab.
Click the top of the Network Request Time (ms) column,  then toggle it to sort the network
requests with the slowest ones at the top.
Skip over network requests that you expect to run for a long time or that have very little load
(low Requests per Minute).
Select and double-click one of the slow network requests that you want to investigate.
In the network request dashboard, view the Key Performance Times at the top of the
Network Request Dashboard.
If the graph shows that most of the time to service the request was server time, scroll down
to the Related Business Transactions section to investigate related business transactions on
the server side.
If most of the time is in the network, the request or response body may be too large and is

 might be slow.taking a while to transmit. Or the data connection

Finding Causes of Slow Network Requests

http://docs.appdynamics.com/display/PRO14S/Monitor+Node.js+Business+Transactions
http://docs.appdynamics.com/display/PRO14S/Monitor+Node.js+Processes
http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Configure+Thresholds
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After you have identified a slow network request that you want to troubleshoot, investigate some
individual instances of that network request using network request snapshots.

To investigate details of the slowest individual requests

Still in the the Mobile APM dashboard, click the Network Request Snapshots tab.
The Network Request Snapshots List opens.
Click .Filters
In the Network Request Names dropdown list under Network in the Filters panel, check the
check box for the network request that you identified in ,To identify slow network requests
then click .Search
This restricts the list to snapshots for that network request only.
Click  again to close the filters panel.Filters
In the list, click the top of the Network Request Time (ms) column, then toggle it to sort the
network request snapshots with the slowest requests at the top.
Select and double-click one of the slow network requests.
The network request snapshot displays the details of the slow request.
Scroll down to see if transaction snapshots associated with this network request snapshot
are available on the server side.
If transaction snapshots are available and if most of the time for this network request is
spent on the server, click on some of the related transaction snapshots to drill down into
causes of slow performance on the server. See .Transaction Snapshots

Learn More

Monitor Network Requests

Troubleshoot Mobile Application Crashes

Identifying Criteria of Applications that Crash Most Often
To identify criteria of applications that crash

Finding Causes of Crashes
To find root cause of individual crashes

Learn More

Use crash dashboards and crash snapshots to troubleshoot mobile application crashes.

Identifying Criteria of Applications that Crash Most Often

Sometimes most of your crashes share one or more criteria. In other words, your application
crashes more often on certain devices or operating systems or carriers or connections.

To identify criteria of applications that crash

In the left navigation pane click either  for iOS applications or End User Experience->iOS E
 for Android applications.nd User Experience->Android

The Mobile APM dashboard opens.
Click the Crashes tab.
Click the Dashboard subtab if it is not already selected.
In the Crashes vs Requests graph, identify values that are significantly above the Average

http://docs.appdynamics.com/display/PRO14S/Transaction+Snapshots
http://docs.appdynamics.com/display/PRO14S/Monitor+Network+Requests
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line. For example, if a device name is above the line, that type of device is experiencing
more crashes than would be expected for the current load.
Scroll down to the section for the criteria that seem to be experiencing more crashes.
In the line graph, note the times that crashes spike. You can hover over a point on the graph
to see the exact number of crashes at that time.

Note the criteria (in this example the IPad 2 WIFI device) and the time that most crashes
seem to occur.

Finding Causes of Crashes

After you have identified which applications are causing most of your crashes and approximately
when most crashes occur, you can examine a few of those individual crashes to identify the cause.

To find root cause of individual crashes

In the Crashes tab of Mobile APM Dashboard, click the Crash Snapshots subtab.
Click .Filters
Check the check box for the criteria of apps experiencing the most crashes that you
identified in .Identifying Criteria of Applications that Crash Most Often
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This filters the crash snapshots list to display only snapshots of crashed applications
meeting those criteria.

In the crash snapshots list, select and double-click a snapshot that occurred around the time
that most crashes occurred. In the stack trace of the crash snapshot, note the thread and
function in which the crash occurred. For some crashes the crashed line number is also
available.
Optional: Click  to get a text version of the stack trace to send to your applicationDownload
development team.

Learn More

Crash Dashboard
Crash Snapshots List
Crash Snapshots
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